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  TÁC DỤNG CỦA TÀI LIỆU NÀY  

  

Tưởng tượng bạn đang làm thuyết minh dự án hay thuyết minh biện pháp thi 

công một công trình. Bạn muốn cắt mục này lên trước mục kia. Bạn phải đánh dấu, 

bấm Ctrl+X, cuộn đến vị trí, kích chuột và Ctrl+V thao tác rõ là lâu, thì giáo trình này 

sẽ giúp bạn chỉ một thao tác là xong.  

Nếu đang làm quản lý hồ sơ, tài liệu của dự án hoặc bạn đang sử dụng phần mềm 

Quản lý chất lượng công trình GXD để làm hồ sơ chất lượng công trình, tài liệu này 

sẽ bổ trợ tốt cho công việc của bạn.  

Bạn có thấy tôi khi thảo luận về các vấn đề chuyên môn xây dựng trên các diễn 

đàn thường dẫn chứng các điều khoản quy định rất nhanh và chính xác? Học và tiếp 

thu nghiêm túc tài liệu này bạn sẽ siêu hơn như vậy.  

Nếu bạn tham gia công việc soạn thảo văn bản Luật (hoặc Nghị định, Thông 

tư…) cùng các sếp và được yêu cầu chỉnh sửa, thêm bớt nội dung. Các ý kiến nhiều 

làm bạn thao tác đến mức cuống không kịp typing hết các ý, rồi một ngày đẹp trời 

bạn gặp “lỗi thằng đánh máy”. Sau giáo trình này sẽ không thế nữa.  

Bạn có biết 1 file Luật, Nghị định, Thông tư, Quyết định bạn soạn chuẩn Styles 

tung ra cho dân sử dụng sẽ giúp cho năng suất lao động toàn xã hội nâng cao lên 

không? Kiên trì đọc đến cuối bạn sẽ hiểu vì sao!  

Bạn có bao giờ tự hỏi viết xong đồ án hay luận văn hay luận án thì làm sao để 

kích chuột là có ngay mục lục? Nếu có chỉnh sửa mục, thêm bớt nội dung thì trong 

vài giây là mục lục và số trang được cập nhật? Thầy hướng dẫn nói chuyển chương 2 

lên trước chương 1 chỉ cần kéo thả 1 phát là xong? Bạn có thấy rất khổ sở khi mở 1 

file tài liệu Word lên, có đoạn muốn copy sang tài liệu của mình, mà copy sang nhảy 

loạn xạ lại phải mất thời gian ngồi trình bày, định dạng lại? Tài liệu này sẽ giúp bạn 

xử lý các vấn đề đó đơn giản, nhanh chóng, nhẹ nhàng.  

Nhờ những kỹ năng sử dụng Word rất tốt khi giảng dạy ở trên lớp, tôi tra cứu tư 

liệu rất nhanh cũng trong các Nghị định, Thông tư giúp cho học viên học năng suất 

hơn và được nhiều hơn. Tôi cũng thường dùng Word làm bảng qua máy chiếu và 

typing nhanh hơn cả viết phấn để giảng bài. Bạn đã từng nghĩ về vấn đề Giảng viên 

giảng năng suất thì sinh viên, học viên học được nhiều hơn chưa? Nếu bạn là giảng 

viên, hi vọng là tài liệu này hữu ích cho bạn nhiều.  

Nhờ kỹ năng Word tốt, trong quãng 1 thời gian rất ngắn mà tôi giới thiệu và cho 

tặng anh/em xây dựng rất nhiều giáo trình, viết rất năng suất và chất lượng đóng góp 

cho đời... Bạn đang viết giáo trình hay luận án? Hi vọng các chức năng Word tôi trình 

bày ở đây sẽ giúp ích cho bạn.  
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Bạn cũng cần 1 tài liệu tốt về Microsoft Word để dạy hoặc giới thiệu cho con 

em, cho nhân viên của mình trong ngành xây dựng? Tài liệu này sẽ đóng vai trò tốt 

giúp bạn thỏa mãn yêu cầu đó.  

Nếu bạn bạn ở vào các tình huống hoặc quan tâm giải quyết các vấn đề nói trên, 

bạn muốn đưa ra giải pháp tiết kiệm thời gian cuộc đời mình và nhiều đồng nghiệp 

khác, thì dù chán hãy theo dõi tiếp thu tất cả những gì tôi trình bày dưới đây nhé.  

Tôi mong rằng qua tài liệu chia sẻ này và sự tự học tìm tòi, sáng tạo và quá trình 

tích lũy bạn sẽ sử dụng Word ở tầm nghệ thuật. Nếu bạn tự tìm tòi và học hỏi tốt rồi 

thì tuyệt vời. Nếu không tự học được hoặc do bận rộn, hãy đến học cùng tôi tại 

khóa học Microsoft Office cho dân văn phòng do GXD tổ chức, tôi sẽ chỉ cho bạn 

cách thực hiện, rất nhiều sáng tạo cùng Tip & Trick. Đảm bảo khóa học sẽ rất 

nhiều điều thú vị.  

Do trình độ, thời gian có hạn, đây lại là version 1.0 nên tài liệu có thể còn có 

những hạn chế, tôi rất mong nhận được các góp ý của bạn đọc về địa chỉ 

theanh@gxd.vn, tôi sẽ cẩn trọng tiếp thu để có version 2.0 tốt hơn.  

Xin chân thành cảm ơn.  

Tác giả  

Ths Nguyễn Thế Anh  

Công ty CP Giá Xây Dựng, https://gxd.vn   

https://gxd.vn/
https://gxd.vn/
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  LỜI TÂM SỰ  

Word và Excel sử dụng nhiều trong công việc và học tập. Nhất là trong văn 

phòng xây dựng hàng ngày phát sinh nhiều văn bản qua lại giữa các bên, đòi hỏi kỹ 

năng soạn mẫu công văn, tờ trình và các tài liệu liên quan sử dụng Word phải nhanh, 

chuyên nghiệp và chuẩn mực.  

Không cứ phải là những gì đao to búa lớn, có những thứ rất đơn giản, ở ngay 

bên ta có thể đem lại hiệu quả cho số đông xã hội. Không phải là những giải pháp 

công nghệ gì cao xa, hiện đại, tự động như BIM, BigData, AI… Tác giả và GXD chỉ 

mong muốn qua tài liệu này thì ngành xây dựng và cả xã hội chuẩn mực ngay từ việc 

sử dụng những phần mềm tưởng đơn giản, phổ thông như Word. Nếu làm được điều 

này cũng đã nâng cao năng suất lao động, nâng cao và đồng bộ dần dần kiến thức cho 

mọi người trên con đường đi đến ứng dụng BIM hay 4.0 trong xây dựng.  

 Thực tế lượng văn bản tạo ra bởi phần mềm Microsoft Word trong máy tính mỗi 

người ở mỗi dự án rất nhiều. Trong máy tính của tôi có đến cả triệu file sưu tầm từ 

khắp các dự án, ôi thôi rồi các loại định dạng… chỉ tính riêng việc nếu các định dạng 

thống nhất nhau theo 1 chuẩn, thì việc tham khảo, tái sử dụng lại các nội dung tính 

cho 1 người làm việc và cả ngành, cả nước sẽ tiết kiệm biết bao nguồn lực.  

Bên cạnh đó, quá trình tham gia giảng dạy gần 20 năm qua, tôi thấy vẫn còn 

nhiều kỹ sư rất kém về những phần mềm tưởng đơn giản như Word, Excel. Thông 

qua các giáo trình, tài liệu và các video tôi hi vọng sẽ chia sẻ được phương pháp làm 

việc chuyên nghiệp với công cụ Word giúp kéo những người mới nhanh lên tầm cao 

hơn. Đồng bộ kiến thức giữa các bên liên quan dự án, giữa những người cùng làm 

việc, làm gì cũng thuận cũng dễ, như vậy cũng như góp phần dọn con đường đi đến 

các ứng dụng trong giải pháp BIM ở Việt Nam nhanh hơn.  

Hi vọng là tài liệu này sẽ hữu ích cho bạn đọc. Có những gì khiếm khuyết mong 

các bạn góp ý về địa chỉ email theanh@gxd.vn hoặc nhắn inbox trực tiếp và facebook 

của tác giả facebook.com/dutoangxd, xin được cẩn trọng ghi nhận để cập nhật trong 

phiên bản sau.  

Tác giả  

Ths Nguyễn Thế Anh  

Công ty CP Giá Xây Dựng, https://gxd.vn   

https://gxd.vn/
https://gxd.vn/


Ứng dụng Word + Quản lý dự án GXD quản lý hồ sơ dự án xây dựng  

Nguồn Công ty CP Giá Xây Dựng https://gxd.vn  6 | P a g e  

  

  CHƯƠNG 1: GIỚI THIỆU, LÀM QUEN MICROSOFT WORD 

TRONG VĂN PHÒNG XÂY DỰNG  

  

I.  Một số khái niệm và chuẩn bị 

1.  Giới thiệu công cụ 

Thời điểm soạn tài liệu này tôi dùng Word 2016, nên để tiện theo dõi bạn hãy 

cài bản Office 2016 nhé. Nếu dùng version khác bạn cần chủ động điều chỉnh trong 

thực hành, để không phải đặt câu hỏi kiểu như: Tại sao phần mềm của em không có 

lệnh đó? sao phần mềm của em không giống như vậy ?  

Trong giai đoạn hiện nay xu thế ứng dụng BIM trong ngành xây dựng là tất yếu, 

nhưng để phổ biến được rộng rãi ở Việt Nam thì phải đồng bộ được kiến thức, phải 

được tiêu chuẩn hóa. Việc bạn nắm bắt cách sử dụng Word và các nội dung trình bày 

trong tài liệu dưới đây cũng là các kiến thức chuẩn bị nền tảng cho cuộc chơi lớn hơn 

với BIM, kiến thức nền tảng để có thể vào BIM được. Nếu những cái này mà còn thấy 

lơ ngơ thì tôi có thể nghi ngờ về việc bạn có thể ứng dụng được những ứng dụng đòi 

trình độ cao trong hệ thống BIM.  

 

Khi sử dụng có thể bạn phải thực hiện 1 số cấu hình Tùy chọn cho Word theo 

nhu cầu và thói quen sử dụng riêng. Bạn vào File > Options để thực hiện Tùy chọn.  

2.  Mục tiêu sử dụng tài liệu  

Bạn có thể sử dụng tài liệu này và các tư liệu đi kèm để soạn thảo:  

- Thuyết minh dự án đầu tư, báo cáo kinh tế kỹ thuật  
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- Thuyết minh biện pháp thi công  

- Trình bày năng lực của nhà thầu  

- Báo cáo thẩm định, thẩm tra  

- Soạn thảo văn bản Luật, Nghị định, Thông tư, Văn bản hướng dẫn về đầu tư xây 

dựng.  

- Luận án, Luận văn, Đồ án, Thông tư, Nghị định  

- .v.v. bất kỳ tài liệu gì cần soạn bằng Word  

Bài tập: Đây là một đoạn trong báo cáo thực tập cán bộ kỹ thuật của Sinh viên 

trường xây. Chỉ vài lỗi chính tả khiến bạn bị mất điểm với nhà tuyển dụng, lãnh đạo, 

đối tác... Hãy đọc và tìm các lỗi, rút kinh nghiệm và chuẩn chỉ từng lỗi nhỏ nhất trong 

tài liệu của mình soạn thảo:  

 

3. Một số thuật ngữ 

- Format: Định dạng. Khi bạn trình bày văn bản ta gọi là Format.  

- Text: Chữ, ký tự. Giờ từ này Việt hóa ta thường gọi luôn là Text, để phân biệt 

với các đối tượng khác như Image (ảnh) hay Shapes (các hình khối).  

- Wrap text: Bẻ dòng  

- Paragraph: Đoạn. Một đoạn Text từ bắt đầu gõ cho đến lần Enter tiếp theo.  

- Justify/Align Left/Right/Center: Căn văn bản đều 2 bên, trái, phải và căn giữa  

- Replace: Thay thế  

- Clipboard: Bộ nhớ đệm  

- Paste: Dán  

- Cut: Cắt  

- Insert: Chèn  

- Navigation Pane: Khung dẫn hướng, khung định hướng  

- Edit: Biên tập  

- Style: Kiểu, mẫu, các định dạng văn bản mẫu.  

- First line: dòng đầu tiên - Indentation/indent: Lề  

- Header/Footer: Phần đầu trang, đỉnh trang/Phần chân trang  

- Page Number: Đánh số trang  
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- Format Painter: Chổi định dạng  

- Table/Column/Row: bảng/cột/hàng  

- Split table: Phân tách bảng  

- Margins: Lề, lề cạnh giấy  

- Orientation: Hướng giấy  

- Format picture: Định dạng ảnh  

- Tab: Vị trí text định vị nhảy text  

- Ruler: Thước  

- Select: Lựa chọn  

- Object: Đối tượng  

- Select Objects: Lựa chọn các đối tượng  

- Border: Viền, đường bao  

- Navigation: Dẫn hướng, định hướng  

- Result: Kết quả  

- Share: Chia sẻ  

Bài tập: Bạn hãy mở Word ra và tìm những chỗ có các thuật ngữ nói trên.  

4.  Chuẩn bị tư liệu thực hành  

Những chuẩn bị này bạn nên tiến hành ngay sau khi vừa cài Word vào máy tính 

hoặc vừa cài lại. File style nên sao lưu sau khi cài lại Word thì copy vào thư mục để 

dùng luôn.  

4.1.  Tải và đưa file Normal.dotm vào vị trí  

Trong Word cho phép tạo file Template (mẫu) tương tự như Dự toán GXD có 

file DutoanGXD.xltm. Những kiểu định dạng hay dùng ta để luôn vào đó, để mỗi lần 

mở file mới là có luôn để dùng.  

Tôi đã chuẩn bị cho bạn và cả ngành xây dựng Việt Nam file Normal.dotm, từ 

nay trở đi chúng ta sẽ dùng chung định dạng chuẩn theo file này, để sau này khi GXD 

có tài liệu gì mới gửi tới bạn, bạn mở ra cần Copy/Paste trích dẫn nội dung nào đó 

đưa sang tài liệu của mình thì sẽ theo chuẩn luôn, không phải định dạng lại khi chúng 

ta sử dụng theo chuẩn thống nhất. Nếu không thì bạn và những người có liên quan sẽ 

mất thêm nhiều thời gian căn chỉnh tài liệu.  

4.1.1. Tải file Normal.dotm  

Để thực hành các lệnh hoặc bài tập theo giáo trình này hoặc sử dụng trong công  

việc trong suốt quá trình sau này, bạn hãy tải file Template có tên Normal.dotm 
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(gọi tắt là temp, mẫu) đã có các Style được định dạng sẵn tại đường link dưới đây:  

http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639  

Bạn tải file Normal.dotm xuống máy tính và đưa vào thư mục theo chỉ dẫn 

bên dưới. Bạn sẽ sử dụng mẫu Normal.dotm này cho công việc nhiều đấy.  

4.1.2. Đặt file mẫu làm mặc định  

Bạn copy file Normal.dotm nói trên vào đường dẫn như sau:  

C:\Users\Username\AppData\Roaming\Microsoft\Templates  

Trong đó phần Username bạn thay bằng tên được đặt trong máy tính của bạn khi 

cài Windows. Ví dụ: Tôi đã copy file Normal.dotm vào thư mục trong máy tính của 

tôi đè lên file mặc định của Word:  

C:\Users\TheAnh\AppData\Roaming\Microsoft\Templates  

Nếu không thấy thư mục AppData bạn phải mở File Explorer và tích chọn như 

sau trong Windows 10 (với các phiên bản khác tìm 2 lựa chọn này hơi khác 1 chút):  

 

Từ giờ trở đi, nếu phải gỡ đi cài lại, thì sau khi cài Microsoft Word, thì nhớ copy 

file Normal.dotm vào đè lên file gốc của Word để sử dụng ngay.  

4.1.3. Thử kết quả từ file mẫu  

Giờ bạn mở Word, nếu trong tài liệu bạn thấy có các Style như trong hình thì là 

bạn đã thực hiện các bước ở trên đúng. Từ bây giờ trở đi, cứ mở file Word lên là bạn 

sẽ có sẵn các mẫu có sẵn để tiện dùng. Chúng ta sẽ thấy rõ sự hiệu quả ở phần sau.  

 

  

  

http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
http://giaxaydung.vn/threads/mau-Word-chuan-Styles-GXD.97639
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Để hiểu rõ nguồn gốc mời xem video.  

Bài tập: Bạn hãy suy ngẫm về các phần mềm Dự thầu GXD có file 

DuthauGXD.xltm, Quyết toán GXD có file QuyettoanGXD.xltm, QLCL GXD có file 

QLCLGXD.xltm và Revit có các template ArchitectureModel.rvt, 

StructuralModel.rvt, ConstructionModel.rvt, SystemsModel.rvt. Rồi suy ngẫm xem 

có phải những gì cứ lặp đi lặp lại qua các công trình thường gặp, thường làm thì đưa 

vào temp sẽ giúp bạn ngày càng giàu có hơn, giảm các thao tác lặp lại không ?  

4.2.  Các file tài liệu để thực hành bài tập và sử dụng  

File các văn bản Luật và Nghị định dùng chuẩn Style GXD, bạn tải xuống vừa 

để thực hành theo giáo trình này vừa sử dụng trong công việc luôn:  

https://giaxaydung.vn/threads/file-thuc-hanh-theo-giao-trinh.97639/post-

263263  

4.3.  Tải mẫu biên bản từ QLCL xuống trình bày  

Chẳng hạn bạn cần soạn 1 quyết định bổ nhiệm Chỉ huy trưởng công trường, 

khỏi mất công mất sức tìm kiếm, thời gian của bạn là vàng bạc. Hãy thao tác nhanh 

như sau:  

Bước 1. Mở phần mềm QLCL GXD, bấm phím tắt Ctrl + Shift + F.  

Bước 2. Trong hộp thoại quản lý thư viện tài liệu mở ra gõ từ khóa Chỉ huy 

trưởng  

Bước 3. Kích phải vào mẫu quyết định chọn tải và mở ra  

Bước 4. Chỉnh sửa các nội dung vào trong mẫu tài liệu  

Tương tự như vậy đối với các loại biểu mẫu, biên bản… có nhiều trong thư viện 

tài liệu GXD. Sau khi tải xong bạn có thể áp dụng các kỹ thuật trình bày văn bản trong 

tài liệu này để tiếp tục.  

4.4.  Tải các mẫu thuyết minh từ Dự toán GXD xuống máy  

Đang thẩm tra dự toán, chẳng hạn bạn cần soạn file Word báo cáo thẩm tra, khỏi 

mất công mất sức tìm kiếm, thời gian của bạn là vàng bạc. Hãy thao tác nhanh như 

sau:  

Bước 1. Mở phần mềm Dự toán GXD, bấm phím tắt Ctrl + Shift + F.  

Bước 2. Trong hộp thoại quản lý thư viện tài liệu mở ra gõ từ khóa thẩm tra  

Bước 3. Kích phải vào mẫu báo cáo thẩm tra, chọn tải và mở ra  

Bước 4. Chỉnh sửa các nội dung vào trong mẫu tài liệu  

Với rất nhiều biểu mẫu khác có nhiều trong thư viện tài liệu GXD bạn cũng làm 

như vậy.  

https://giaxaydung.vn/threads/file-thuc-hanh-theo-giao-trinh.97639/post-263263
https://giaxaydung.vn/threads/file-thuc-hanh-theo-giao-trinh.97639/post-263263
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 Tương tự đối với phần mềm Dự thầu GXD bạn có kho Biện pháp thi công.  

 Đối với phần mềm Quyết toán GXD bạn có kho biểu mẫu tài liệu phục vụ 

công tác hợp đồng xây dựng, thanh toán khối lượng hoàn thành, quyết toán vốn 

đầu tư.  

 Đối với phần mềm Quản lý tài liệu GXD bạn có cả kho tư liệu quản lý dự án.  

5.  Chuẩn bị về soạn thảo và trình bày văn bản  

5.1.  Chiến lược trình bày cả văn bản dài  

Để tiết kiệm thời gian và công sức trình bày văn bản, nhất là những văn bản dài 

vài chục đến vài trăm trang bạn cần có chiến lược, chiến thuật. Tôi từng thấy nhiều 

kỹ sư ngồi tỉ mẩn trình bày từng chỗ một trong văn bản mất cả tuần. Vậy không ổn. 

Bạn hãy Ctrl + A để đánh dấu toàn bộ văn bản chọn style Nội dung, sau đó mới đi 

trình bày những chỗ cá biệt, ví dụ như là: đánh các mục (số lượng lớn trình bày trước, 

các cá biệt làm riêng).  

Quá trình trình bày bạn hãy cuộn từ trên xuống cuối văn bản và thao tác những 

gì giống nhau bằng cách thao tác lần đầu và ấn F4 cho những lần sau. Ví dụ : Trong 

tài liệu có rất nhiều ảnh, tôi cần áp Style Hình ảnh cho tất cả các ảnh, tôi có thể làm 

bằng cách chọn ảnh 1 và chọn Style Hình ảnh, sau đó lần lượt cuộn và chọn các ảnh 

khác và ấn F4, như thế cho đến hết, rồi lại quay lên đầu văn bản trình bày các tác vụ 

khác tương tự.  

5.2.  Chiến thuật lập dàn bài đề cương  

Xin chia sẻ với bạn Kinh nghiệm để biên soạn 1 tài liệu, bạn có thể áp dụng khi 

làm Đồ án, Luận văn, Luận án, báo cáo Nghiên cứu khoa học, soạn giáo trình hay bất 

kỳ tài liệu.  

- Bạn hãy mở 1 file Word mới, tạo các chương phần trước, tiếp theo tạo các mục 

lớn, các mục nhỏ. Chưa cần chính xác, chưa cần đúng trình tự, chỉ cần nhanh chóng 

đưa ra các vấn đề lớn, quan trọng trong nội dung của mình.  

- Sau đó viết nội dung và kéo thả sắp xếp các mục trong quá trình biên soạn.  

- Hoàn thiện tài liệu chi tiết dần để đạt được mục tiêu, hoàn thiện tác phẩm.  

Bài tập: Bạn mở Word ra, tạo đề cương để viết 1 báo cáo khoa học.   

Bước 1. Mở Word và có 1 file trắng tinh tất nhiên với Styles GXD nhé  

Bước 2. Bạn hãy gõ vào tên các chương trước: Chương 1, Chương 2, Chương 3 

và chọn áp Styles Heading 1 cho chúng  

Bước 3. Tiếp theo bạn gõ các mục lớn, ví dụ: Cơ sở lý luận, Cơ sở pháp lý và áp 

Styles Haeading 2 cho các mục này  
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Bước 4. Bạn tạo các mục Heading 3, sau đó là Heading 4. Nhớ lưu file lại kẻo 

có sự cố lại mất công sức làm lại.  

Bây giờ bạn cứ đưa trỏ Text vào giữa một mục nào đó mà bạn muốn viết và Enter 

xuống. Cứ viết và đưa nội dung vào, sau này bạn có thể kéo thả và thay đổi vị trí các 

mục các nội dung.  

Việc tạo đề cương từ tổng quát đến chi tiết này giúp bạn quản lý và xây dựng nội 

dung tài liệu cho bạn rất tốt.  

5.3.  Làm việc nhóm kết hợp Google Doc và Microsoft Word  

Tôi chia sẻ kinh nghiệm rút ra từ câu chuyện nhóm giảng viên GXD chúng tôi 

cùng biên soạn giáo trình dự toán. Giáo trình gồm 3 phần, tôi viết phần 1 + phần 3 + 

bài 1 + một phần bài 10 và chịu trách nhiệm tổng hợp kết quả, 8 thầy khác viết các 

bài từ 2 đến 9 và từng phần bài 10. Chúng tôi là những người có trình độ cao, khá là 

giỏi các phần mềm máy tính. Mặc dù đã chuẩn bị 1 styles Word được thống nhất trước, 

mặc dù vậy khi tổng hợp kết quả từ các file của các thầy gửi ghép lại 1 file giáo trình 

duy nhất mà vẫn mất rất nhiều thời gian, vì tài liệu nhảy xô lệch lung tung, mỗi ông 

vẫn có những sai khác đáng kể.  

Rút ra từ sau dự án biên soạn giáo trình dự toán đó 1 số kinh nghiệm cho bạn: 

Ngoài việc chuẩn bị 1 file styles chung cho cả nhóm, hãy dùng Google Doc để soạn 

chung 1 tài liệu và share để cả nhóm có thể đồng thời biên soạn trên đó. Sau đó có 

thể copy hoặc xuất ra Word để trình bày, định dạng thêm.  

6.  Khái niệm CDE, teamwork và công nghệ đám mây  

Để đồng bộ dữ liệu giữa máy tính cơ quan – laptop và máy tính ở nhà, hoặc tổ 

chức 1 dự án làm việc Teamwork bạn sử dụng giải pháp Dropbox như sau:  

Bước 1. Chuẩn bị tài khoản lưu trữ đám mây  

Trước khi bắt tay vào công việc mỗi người cần có 1 tài khoản Dropbox.com.  

Hoặc dùng Google Drive hoặc Box.net cũng được.   

Bước 2. Chuẩn bị thư mục lưu trữ, đồng bộ và chia sẻ tài liệu  

Cài ứng dụng Dropbox vào máy tính và đặt 1 thư mục lưu trữ và đồng bộ dữ 

liệu, ví dụ: D\Dropbox.  

Bước 3. Tạo 1 thư mục dự án và share cho Team  

Người chủ trì (hoặc trưởng phòng) tạo thư mục dự án, ví dụ :  

D:\Dropbox\DutoanGXD. Kích phải vào thư mục đó và chọn Share  
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Nhập email những người trong Team vào rồi bấm Share:  

  

Bây giờ cả nhóm có thể thả các tài liệu chia sẻ vào đây. Ai làm gì thả vào sẽ đồng 

bộ lên Server của Dropbox và đồng bộ xuống máy những người được share.  

Đối với các máy tính khác nhau của bạn, thì bạn dùng tài khoản của mình đăng 

nhập vào từng máy tính, dữ liệu sẽ tự đồng bộ qua Dropbox. Chia tay USB và virus 

Autorun.  

Sau 1 thời gian làm việc nhóm như trên bạn sẽ dần hiểu được thế nào là CDE 

Common Data Environment - môi trường dữ liệu chung trong BIM.  
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  CHƯƠNG 2: THỰC HÀNH TRÌNH BÀY ĐỊNH DẠNG   

1.  Tìm kiếm nội dung trong Word  

Bạn sẽ phát huy mạnh chức năng này khi sử dụng với file ghép các văn bản Luật, 

Nghị định về xây dựng thường dùng vào với nhau.  

Bạn thực hành như sau: Mở file Luật Nghị định đã tải xuống ở trên, bấm tổ hợp 

phím Ctrl + F và gõ từ khóa cần tìm kiếm  

- Ví dụ 1: Bạn được sếp giao soạn phụ lục hợp đồng, bạn cần tìm hiểu quy định 

về điều chỉnh tiến độ hợp đồng. Bạn gõ cụm từ Tiến độ hợp đồng vào Navigation. 

Ngay lập tức bạn sẽ tìm thấy nội dung cần tìm  

- Bạn có thể thấy ở văn bản phía bên phải  

- Bạn có thể thấy ở Mục 5 được hightlight màu vàng  

- Và bạn có thể kích vào Results để thấy các kết quả khác  

 

- Ví dụ 2: Có người hỏi bạn là Tư vấn giám sát có phải xác nhận khối lượng khi 

giám sát thi công không? Hay đó là việc của Chủ đầu tư. Bạn cần tìm tất cả các quy 

định có liên quan đến cụm từ “xác nhận khối lượng”. Hãy Cltr + F và gõ vào “xác 

nhận khối lượng” rồi kích vào results, sau đó kích lần lượt vào từng kết quả bên dưới 

và xem nội dung, sau đó kích lại headings để xem nó ở điều khoản nào, văn bản nào.  
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2.  Sử dụng khung Navigation  

Mở lên bằng cách bấm Ctrl + F hoặc lệnh View > Navigation Panel  

2.1.  Di chuyển giữa các mục  

Bạn mở file Word các văn bản luật đã tải ở trên ra thực hành luôn. Sau khi mở, 

bạn muốn chuyển nhanh qua Nghị định 68/2019/NĐ-CP hoặc Nghị định số 

46/2015/NĐ-CP thì làm thế nào ? Bạn chỉ việc mở Navigation Panel rồi kích vào các 

mục tương ứng thay vì dùng bi xoay cuộn mãi 1 lúc rõ lâu. Bạn có thể kích vào biểu 

tượng tam giác nhỏ bên cạnh đề mục để xòe ra, cụp vào điều khiển di chuyển cho 

nhanh.  

  

2.2.  Biên tập sắp xếp giữa các mục  

Kích vào các mũi tên nhỏ để mở ra hoặc cụp lại các mục. Kích phải vào các  
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mục và chọn Promote hoặc Demote để tăng giảm heading. Kích vào mục đó kéo 

thả lên trên hoặc xuống dưới 1 mục khác để sắp xếp các mục. Xóa một mục thì kích 

phải vào chọn Delete, nhưng hãy cẩn trọng nhé. Các chức năng kéo thả hoặc xóa có 

thể Word 2010 trở về trước chưa có, phải từ bản 2013 trở đi.  

 

Bạn có thể liên hệ chức năng này với chức năng Outline của Microsoft Project 

khi tạo cấp công việc (indent task và outdent task) hoặc công tác tóm lược (Project 

Summary task) để khi dùng Project dễ hiểu hơn.  

3.  Lựa chọn, đánh dấu trong Word  

Ngay cả việc lựa chọn, đánh dấu tưởng đơn giản mà nhiều người cũng chưa biết 

hết cái sự hay và nghệ thuật của nó.  

Bạn hãy để ý vào con chuột, khi ở giữa văn bản nó là dấu gạch thẳng nháy nháy 

gọi là trỏ text, khi bạn di chuột xuất hiện mũi tên màu trắng nghiêng sang trái, nhưng 

bạn di sang lề phải của văn bản hoặc bảng biểu chuột sẽ ngoảnh sang phải, kích 1 

nhát là lựa chọn.  

Bạn có thể kích đúp để lựa chọn 1 từ. Khi đưa trỏ chuột ra lề trái văn bản bạn 

kích 1 lần để lựa chọn 1 dòng, kích đúp để lựa chọn cả đoạn. Kích 3 lần liên tiếp là 

lựa chọn toàn bộ văn bản (tương tự bấm Ctrl+A)  

Kích vào vị trí đầu, giữ Shift kích vào vị trí cuối để lựa chọn 1 đoạn văn bản. 

Bạn có thể nhấn giữ phím Shift rồi dùng các phím mũi tên di chuyển tứ phía để lựa 

chọn. Hoặc có thể giữ Shift rồi dùng phím PgUp, PgDown để lựa chọn.  

Chọn 1 đoạn văn bản, giữ Ctrl để kích chọn các đoạn khác nằm cách quãng.  

Bạn cũng nên khám phá lệnh Home > Select, trong đó có các lệnh lựa chọn đối 

tượng, lựa chọn text khá hay. Khi cần đến mới thấy rất hữu ích.  

4.  Trọn bộ phím tắt Word dùng cả đời  

Nắm bắt và nhớ các chức năng của các phím tắt này sẽ giúp bạn thao tác nhanh 

hơn, công việc thú vị hơn và chuyên nghiệp hơn. Đặc biệt là khi bạn thuộc các phím 
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tắt này của Word, bạn có thể sử dụng sang nhiều chương trình khác cũng có thể chức 

năng tương tự (chẳng hạn Excel, PowerPoint, AutoCad, Dự toán GXD,...). Như vậy 

là học 1 mà được nhiều.  

Các ảnh này tôi sưu tầm được từ 1 chia sẻ trên Facebook, thấy hay nên xin chia 

sẻ lại với bạn đọc. Hãy nhớ là phải sử dụng được tất cả các phím trên bàn phím, không 

có 1 phím nào là thừa cả, nếu bạn chưa dùng hết cách phím thì giống như bạn giải bài 

toán chưa dùng hết các dữ kiện, có vẻ sẽ có vấn đề.  
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5.  Định dạng toàn bộ văn bản  
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- Bạn có thể đổi màu toàn bộ văn bản sang màu đỏ như sau: Bấm Ctrl + A để 

chọn toàn bộ văn bản, sau đó kích vào biểu tượng Font Color để chọn màu đỏ.  

- Bạn đổi toàn bộ văn bản sang gạch chân hoặc chữ nghiêng bằng cách tương tự.  

- Nếu muốn xóa toàn bộ định dạng của văn bản, kể cả các đề mục để đưa hết về 

dạng text thô thì làm thế nào? Bạn bấm Ctrl + A để lựa chọn toàn bộ văn bản, sau đó 

dùng tay trái bấm Ctrl + Alt + Shift + S để hiện panel Styles, chọn Clear All.  

 

6.  Đổi màu toàn bộ văn bản về đen trắng để in  

Quá trình soạn thảo, biên tập có thể bạn sẽ dùng chỉ thị màu chữ văn bản (Font 

Color) bản hoặc màu nền (Text Hightlight Color) để đánh dấu tiện xem lại biên tập 

hoặc làm nổi bật sự chú ý. Nhưng khi vội bạn quên không đổi lại màu chữ đen trắng 

và bỏ màu nền đi. Điều đó làm cho tài liệu in ra vẫn còn vết đánh dấu, còn các chữ 

có màu sẽ bị mờ khi in đen trắng, hoặc bị nổi bật gây chú ý không đáng có.  

Cách đơn giản và rất nhanh là: Trước khi in bạn bấm Ctrl + A và chọn màu đen 

cho màu chữ và chọn No Color với nút Text HightLight Color.  
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7.  Trình bày phần tiêu đề văn bản và phần nơi nhận, chữ ký  

Cách trình bày: Dùng bảng, chia 2 cột và căn giữa, nhập nội dung vào. Sau đó 

đánh dấu bảng và bỏ đường viền bảng.  

Bài tập 1: Hãy trình bày phần tiêu đề, quốc hiệu của văn bản như dưới đây. Bạn 

thực hiện theo trình tự như sau:  

- Bước 1. Chèn 1 bảng có 1 dòng, 2 cột  

- Bước 2. Nhập văn bản vào trong  

- Bước 3. Căn chỉnh cho đẹp  

BỘ XÂY DỰNG 

 

 

Số : 1776/BXD-VP 

V/v : Công bố Định mức 

dự toán xây dựng công 

trình – Phần Xây dựng 

 CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

 

Hà Nội, ngày 16 tháng 08 năm 2007 

- Bước 4. Vẽ đường gạch dưới  

Bạn dùng lệnh Inset > Shapes > Line để vẽ và Format > Shapes > Outline để 

định dạng đường kẻ.  
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Bài tập 2: Hãy trình bày phần nơi nhận, chữ ký trong văn bản như dưới đây.  

Bạn thực hiện theo trình tự như sau:  

- Bước 1. Chèn 1 bảng có 1 dòng, 2 cột  

- Bước 2. Nhập văn bản vào trong  

- Bước 3. Căn chỉnh cho đẹp  

Nơi nhận :  

- Công ty CP Giá Xây Dựng;  

- Lưu VP, TA(5)  

GIÁM ĐỐC  

  

NGUYỄN VĂN A  

8.  Trình bày nội dung của 1 đoạn  

Bạn kích chuột vào đoạn bất kỳ, sau đó chọn Style A Noi dung gxd.vn. Nếu bạn 

soạn thảo nội dung văn bản mới từ Style GXD thì ngay sau khi tạo mục, Enter xuống 

thì Word tự động vào Style A Noi dung gxd.vn ngay, bạn chỉ việc nhập text mà không 

phải định dạng nữa.  
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Tại sao lại đặt tên A Noi dung gxd.vn ? là vì Word sắp xếp Style trong Panel 

Style theo Alphabel, do Style này hay dùng, tôi đánh chữ A để sắp xếp lên phần đầu, 

tiện chọn nữa, còn Noi dung để nhắc là đây là Style hay dùng cho phần nội dung văn 

bản, gxd.vn là để đánh dấu chuẩn Style.  

9.  Đánh ký hiệu bullet tự động  

Bạn có thể đánh bullet gạch đầu dòng bằng dấu trừ, dấu cộng, dấu tròn, mũi tên, 

chỉ tay… trong Styles có sẵn hoặc tự tạo thêm.  

Bài tập: Bạn hãy thực hiện đánh gạch đầu dòng cho đoạn văn gồm các ý sau:  

Hệ thống các phần mềm GXD xây dựng theo chuỗi sinh thái quản lý chi phí đầu 

tư xây dựng xuyên suốt từ đầu đến cuối dự án, gồm:  

- Phần mềm Dự án GXD: dùng để lập Tổng mức đầu tư, tính hiệu quả dự án - 

Phần mềm Dự toán GXD: dùng để lập và thẩm tra dự toán thiết kế, cũng có thể sử 

dụng để lập giá thầu và nhiều chức năng khác, tra cứu tài liệu biểu mẫu pháp lý liên 

quan đến quản lý chi phí  

- Phần mềm Dự thầu GXD: chuyên dụng cho nhà thầu dự toán dự thầu để làm hồ 

sơ thầu tham dự các gói thầu, hạch toán chi phí thi công, tra cứu hệ thống mẫu biện 

pháp thi công  

- Phần mềm Quản lý chất lượng GXD: đảm nhiệm hệ thống hồ sơ chất lượng, hồ 

sơ hoàn thành công trình, nhật ký thi công, tra cứu tài liệu biểu mẫu pháp lý liên quan 

đến chất lượng  

- Phần mềm Quyết toán GXD: chuyên dùng để thanh toán giá trị khối lượng hoàn 

thành, quyết toán A-B, báo cáo quyết toán vốn  

10.  Đánh số number tự động  
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Bạn có thể chọn thêm các kiểu đánh số thứ tự bằng cách chọn đoạn văn bản và 

chọn Style GXD Danh list số hoặc có thể dùng nút Numbering.  

Bài tập: Bạn hãy mở file Word, nhập vào nội dung và thực hiện đánh số thứ tự 

cho đoạn văn bản trình bày về nội dung quản lý thi công xây dựng như sau:  

Quản lý thi công xây dựng công trình bao gồm:  

1. Quản lý chất lượng xây dựng công trình.  

2. Quản lý tiến độ thi công xây dựng công trình.  

3. Quản lý khối lượng thi công xây dựng công trình.  

4. Quản lý chi phí đầu tư xây dựng trong quá trình thi công xây dựng.  

5. Quản lý hợp đồng xây dựng.  

6. Quản lý an toàn lao động, môi trường xây dựng.  

11.  Chỉnh sửa định dạng các đề mục  

Khi muốn thay đổi đồng loạt định dạng của các đề mục, chỉ việc chỉnh Style 

bằng cách:  

Kích phải vào Style và chọn Modify…  

 

Trong hộp thoại Modify Style hiện ra chọn lại cỡ chữ từ 13 đổi 14 và màu chữ 

đỏ chẳng hạn, bấm OK. Khi đó tất cả các mục trong văn bản sử dụng chung Style này 

đều thay đổi.  
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Mẹo : Quá trình thao tác định dạng hoặc nhập dữ liệu, nếu có chỗ nào đó nhảy 

tự động không như ý, bạn hãy bấm Ctrl+Z, ví dụ hay gặp nhất là khi gõ cặp dấu nháy 

kép « «  nó nhảy không được như ý mong muốn là " ", khi gõ bạn dùng Ctrl+Z sẽ 

được như ý muốn.  

  

12.  Trình bày nội dung 1 bảng  

Trình bày phần đầu văn bản gồm Tên cơ quan, tổ chức ban hành văn bản, Quốc 

hiệu, địa điểm và ngày tháng.  

Sau nhiều năm làm việc, tôi khuyên bạn nên dùng 1 bảng gồm 2 ô để trình bày 

nội dung này, sẽ đẹp và thuận tiện hơn. Thao tác như sau:  

Bước 1. Bạn chèn 1 bảng gồm 2 ô  

    

Bước 2. Bạn đưa nội dung vào bảng  

Bên trái là Tên cơ quan, tổ chức ban hành văn bản và có thể là cả trích yếu.  

Bên phải là Quốc hiệu và dòng địa điểm, ngày tháng.  

Ví dụ:  
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CÔNG TY CP GIÁ XÂY DỰNG  

  

V/v đề xuất sử dụng phần mềm QLCL 

GXD để quản lý chất lượng công trình 

CỘNG HÒA XÃ HỘI CHỦ NGHĨA  

VIỆT NAM  

Độc lập – Tự do – Hạnh phúc 

Hà Nội, ngày 01 tháng 01 năm 2020 

  

Bước 3. Trình bày bảng  

Sau khi nhập xong nội dung bạn hãy đi trình bày bảng và thường chỉ là lần đầu 

thôi. Từ lần sau trở đi, hãy mở 1 văn bản có sẵn copy phần này sang, sửa trích yếu và 

ngày tháng là được.  

Để trình bày bảng trên bạn làm như sau :  

Bước 1. Chọn toàn bộ bảng  

Đưa trỏ chuột lên góc trên bên trái bảng sẽ thấy 1 ô vuông nhỏ có mũi tên 4 

chiều xuất hiện, kích vào đó sẽ chọn cả bảng. Xem hình dưới:  

 

Bước 2. Áp style cho nội dung bảng  

Mở khung Styles và chọn Gxd.vn Noi dung Ban can Giua Dam B. Sau đó đưa 

trỏ chuột đến đường phân cách kéo về bên trái co bớt độ rộng của cột trái  

 

CÔNG TY CP GIÁ XÂY DỰNG  

  

V/v đề xuất sử dụng phần mềm 

QLCL GXD để quản lý chất lượng 

công trình  

CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc  

  

Hà Nội, ngày 01 tháng 01 năm 2020  
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Bước 3. Bỏ đường viền của bảng  

Kích chọn đánh dấu cả bảng, rồi kích vào nút Border chọn bỏ tất cả đường viền 

đi, giờ ta sẽ có bảng vô hình, in ra không thấy các đường bao, nhưng lại giúp giữ cho 

các nội dung  

  

Khi muốn thay đổi cỡ chữ đồng loạt của tất cả các bảng trong file, chỉ việc chỉnh 

Style bằng cách :  

Kích phải vào Style  

Chọn Modify…  

Trong hộp thoại Modify Style hiện ra chọn lại cỡ chữ 12 chẳng hạn, bấm OK. 

Khi đó tất cả các bảng trong văn bản sử dụng chung Style này đều thay đổi.  

13.  Lặp lại tiêu đề bảng  

Với 1 bảng dài qua 2 trang trở lên trong văn bản, nếu bạn không để lặp lại tiêu 

đề bảng thì từ trang thứ 2 trở đi rất khó theo dõi và xấu. Nhiều bạn không biết thì đi 

copy dòng tiêu đề rồi đi chèn vào vị trí ở tất cả các trang sau, rất mất công, nhiều khi 

bị nhảy trang thì lại đi trình bày lại. Ví dụ như bảng đơn giá dưới đây, nếu bạn không 

chọn lặp lại tiêu đề, thì đơn giá 1 có tiêu đề, đơn giá 2 không có tiêu đề nhìn không 

biết cột nào nội dung là gì, rất khó theo dõi, lại còn xấu nữa.  
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Để lặp lại các tiêu đề tự động, bạn hãy copy 1 bảng dữ liệu bất kỳ vào Word rồi 

thực hành ngay như sau:  

Bước 1. Đưa chuột ra lề trái, kích và di chuột để chọn những dòng muốn lặp lại 

tiêu đề. Ví dụ ở bảng dưới chọn 2 dòng đầu.  

Bước 2. Chọn lệnh Layout > Repeat Header Rows.  

STT  

MÃ  

HIỆU  

ĐƠN 

GIÁ  

MSVT  

TÊN CÔNG VIỆC /  

THÀNH PHẦN HAO  

PHÍ  

ĐƠN  

VỊ  

ĐỊNH  

MỨC  

HAO PHÍ  

ĐƠN  

GIÁ  

VẬT TƯ  

THÀNH 

TIỀN  

[1]  [2]  [3]  [4]  [5]  [7]  [8]  [10]  

1  AB.25112     

Đào móng công trình, 

chiều rộng móng <=6 

m, bằng máy đào 

<=0,8 m3, đất cấp II  

100m3           

         Nhân công     1     1.167.480  
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STT  

MÃ  

HIỆU  

ĐƠN 

GIÁ  

MSVT  

TÊN CÔNG VIỆC /  

THÀNH PHẦN HAO  

PHÍ  

ĐƠN  

VỊ  

ĐỊNH  

MỨC  

HAO PHÍ  

ĐƠN  

GIÁ  

VẬT TƯ  

THÀNH 

TIỀN  

[1]  [2]  [3]  [4]  [5]  [7]  [8]  [10]  

   
 

   
N1307  

Nhân công 3,0/7 

(nhóm 1)  
công  6,11  191.077  1.167.480  

         Máy thi công     1     952.615  

      M0006  Máy đào 0,8m3  ca  0,372  2.560.793  952.615  

2  AF.81111     

Ván khuôn cho bê 

tông đổ tại chỗ, ván 

khuôn gỗ, ván khuôn 

móng  

dài, bệ máy  

100m2           

         Vật liệu     1     5.735.655  

      V10447  Gỗ ván  m³  0,792  4.090.909  3.240.000  

      V10435  Gỗ đà nẹp  m³  0,0865  4.090.909  353.864  

      V10432  Gỗ chống  m³  0,459  4.090.909  1.877.727  

      V10329  Đinh  kg  12  17.273  207.276  

      V19999  Vật liệu khác  %  1     56.789  

         Nhân công     1     2.835.329  

      N1357  
Nhân công 3,5/7 

(nhóm 1)  
công  13,61  208.327  2.835.329  

3  AF.11111     

Bê tông sản xuất bằng 

máy trộn - đổ bằng 

thủ công, bê tông lót 

móng, đá 4x6, chiều 

rộng <=250 cm, mác 

100  

m3           

         Vật liệu     1     475.210  

      V10896a        198,79  1.400  278.306  

      V10135  Cát vàng đổ bê tông  m³  0,52118  54.545  28.428  

      V10282  Đá 4x6  m³  0,92288  181.818  167.796  

      V10543  Nước  lít  169,95  4  680  

         Nhân công     1     271.329  

      
N1307  

Nhân công 3,0/7 

(nhóm  
công  

1,42  191.077  271.329  
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STT  

MÃ  

HIỆU  

ĐƠN 

GIÁ  

MSVT  

TÊN CÔNG VIỆC /  

THÀNH PHẦN HAO  

PHÍ  

ĐƠN  

VỊ  

ĐỊNH  

MỨC  

HAO PHÍ  

ĐƠN  

GIÁ  

VẬT TƯ  

THÀNH 

TIỀN  

[1]  [2]  [3]  [4]  [5]  [7]  [8]  [10]  

   1)      

         Máy thi công     1     46.680  

      M0313  Máy trộn bê tông 250l  ca  0,095  286.032  27.173  

      M0350  Đầm bàn 1Kw  ca  0,089  219.183  19.507  

 

14.  Đánh số thứ tự trong bảng  

Khi biên tập giáo trình Quyết toán GXD, tôi có biên tập chương các câu hỏi trắc 

nghiệm về hợp đồng và thanh quyết toán. Quá trình biên tập phải đảo lộn các câu hỏi 

thấy mất công phải đánh lại STT quá, tôi liền Google và tìm ra cách như sau, xin chia 

sẻ với bạn.  

Bạn chèn cột STT vào bảng dữ liệu, trong cột đó không chứa gì cả. Bạn chọn cả 

cột STT và chọn đánh số number tự động (chỉ cần kích chọn cột đó và đánh numbering 

là được).  

Thực sự là khi đang làm việc quá nhiều và lặp đi lặp lại nhàm chán, tìm ra được 

chỉ dẫn nhanh chóng thấy tâm lý thoải mái, vui vẻ và thích thú ghê lắm.  

Bạn tham khảo thêm video: https://youtu.be/Ln1OtgZoao0  

Bài tập: Bạn hãy áp dụng ngay kiến thức đánh số thứ tự trong bảng vừa mới biết 

thực hành trình bày bảng dữ liệu câu hỏi trắc nghiệm như dưới đây. Chú ý là trình bày 

đúng mẫu như vậy và trong thời gian ngắn nhất nhé.  

Stt  
 

Câu hỏi  Đáp án  

1  

   
Dự án đầu tư xây dựng được phân thành loại và nhóm A, B, C 

đối với các nguồn vốn nào?  

D  

A.  Nguồn vốn ngân sách nhà nước  

B.  Nguồn vốn nhà nước ngoài ngân sách  

C.  Nguồn vốn khác không phải nguồn vốn nêu tại đáp án A và B  

D.  Tất cả các nguồn vốn nêu tại điểm A, B và C  

2  

   
Theo quy định của pháp luật về xây dựng hiện hành, vốn nhà 

nước ngoài ngân sách bao gồm:  
D  

A.  
Vốn ODA, vốn vay ưu đãi của Nhà nước, vốn do Nhà nước bảo lãnh 

vay  

https://youtu.be/Ln1OtgZoao0
https://youtu.be/Ln1OtgZoao0
https://youtu.be/Ln1OtgZoao0
https://youtu.be/Ln1OtgZoao0
https://youtu.be/Ln1OtgZoao0
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Stt  
 

Câu hỏi  Đáp án  

 
B.  

Vốn phát triển của doanh nghiệp nhà nước, vốn góp tiền sử dụng đất 

của Doanh nghiệp nhà nước  

 

C.  Các dự án PPP  

D.  Các trường hợp ở các đáp án trên  

3  

   

Theo quy định của pháp luật về xây dựng hiện hành, giai đoạn 

chuẩn bị đầu tư xây dựng không bao gồm những công tác nào 

sau đây?  

  

A.  Xin chủ trương đầu tư xây dựng  

B.  
Lập, thẩm định, phê duyệt Báo cáo nghiên cứu khả thi hoặc Báo cáo 

kinh tế - kỹ thuật đầu tư xây dựng  

C.  Tổ chức lựa chọn nhà thầu và ký hợp đồng xây dựng  

D.  Quyết toán hợp đồng xây dựng, bảo hành công trình xây dựng  

4  

   
Theo quy định của pháp luật về xây dựng hiện hành, công việc 

nào sau đây không thuộc giai đoạn thực hiện dự án?  

  

A.  Quyết toán hợp đồng xây dựng, bảo hành công trình xây dựng  

B.  
Tổ chức lựa chọn nhà thầu và ký kết hợp đồng xây dựng; thi công 

xây dựng công trình; giám sát thi công xây dựng  

C.  
Tạm ứng, thanh toán khối lượng hoàn thành; nghiệm thu công trình 

xây dựng hoàn thành  

D.  
Bàn giao công trình hoàn thành đưa vào sử dụng; vận hành, chạy thử 

và thực hiện các công việc cần thiết khác  

5  

   

Theo quy định của pháp luật về xây dựng, Giai đoạn kết thúc 

xây dựng đưa công trình của dự án vào khai thác sử dụng gồm 

các công việc gì?  

  

A.  Xin chủ trương đầu tư xây dựng  

B.  
Lập, thẩm định, phê duyệt Báo cáo nghiên cứu khả thi đầu tư xây 

dựng  

C.  Xin phép xây dựng, tổ chức lựa chọn nhà thầu  

D.  Quyết toán hợp đồng xây dựng, bảo hành công trình xây dựng  

Xin hướng dẫn bạn một cách làm chuyên nghiệp như sau:  

Bước 1. Bắt đầu hãy chèn bảng có 1 dòng và 4 cột  

Để ý là bảng trên là 4 cột chứ không phải 3 cột bạn nhé !  

        

Bước 2. Bạn nhập tiêu đề vào bảng  
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Bắt đầu từ STT, sau đó ấn Tab để di chuyển sang ô bên cạnh nhập Câu hỏi, nhấn 

Tab 2 lần bỏ qua 1 ô nhập Đáp án vào cột cuối.  

Stt  
Câu 

hỏi    Đáp án  

Bước 3. Bạn bắt đầu nhập dữ liệu vào bảng  

Sau khi nhập xong ô Đáp án, lúc này trỏ text của bạn đang ở ô cuối cùng của 

bảng, bạn ấn Tab để tạo ra 1 dòng tiếp theo.  

Stt  
Câu 

hỏi    Đáp án  

        

Nhập dữ liệu vào bảng, cứ đến ô cuối thì ấn Tab để tạo dòng tiếp theo:  

Stt  
Câu 

hỏi    Đáp án  

    
Dự án đầu tư xây dựng được phân thành loại và nhóm A, B, C 

đối với các nguồn vốn nào?  D  

  A  Nguồn vốn ngân sách nhà nước    

Bước 4. Căn chỉnh bảng như mẫu trong đề bài  

Bước 5. Đánh số thứ tự  

Đưa trỏ chuột lên đỉnh cột Stt để chọn cả cột, chọn đánh numbering.  

Bạn có biết vì sao tôi lại hướng dẫn bạn ấn Tab tạo thêm dòng thay vì tạo luôn 

ra 1 bảng với đủ dòng, đủ cột rồi mới nhập dữ liệu vào không ?  

Có nhiều cách khác nhau để làm bài tập này, ở đây giới thiệu với bạn 1 cách thôi, 

bạn hãy linh hoạt trong ứng dụng nhé, luôn nghĩ cách nào nhanh hơn, tốt hơn.  

15.  Chèn hình ảnh (logo) vào biên bản  

Bạn dùng lệnh Insert > Picture, sau đó trỏ đến ảnh logo của bạn để chèn vào 

văn bản :  

 

Ví dụ: ở đây tôi chèn logo GXD, nếu không sẵn có logo GXD bạn có thể lấy  
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ảnh bất kỳ để thực hành lệnh này, hoặc lên Google search logo GXD, miễn là nhanh 

chóng để có tư liệu để tập trung vào thực hành lệnh mình đang tìm hiểu.  

  

Sau khi chèn ảnh hoặc logo vào văn bản, bạn kích vào ảnh kéo thả đến vị trí 

mong muốn. Nếu kéo thả chưa được, bạn kích phải vào ảnh và chọn Wrap Text > In 

Front of Text. Rồi sau đó hãy kéo thả ảnh đến vị trí, bạn tìm hiểu thêm các lựa chọn 

khác trong menu phụ Wrap Text nhé, ví dụ lệnh Ảnh nằm bình đẳng với Text (In Line 

with Text) cũng hay dùng.  

 

 

 

 

 

 

 

 

 

16. Trình bày header and footer  

Để trình bày header and footer có nhiều cách, bạn có thể chuyển lên header hoặc 

xuống footer của văn bản, kích đúp vào đó và đưa nội dung vào.  

Bài tập: Hãy trình bày header và footer của tài liệu theo mẫu sau:  
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Thực hiện bài tập này cũng dễ thôi, bạn làm theo trình tự sau:  

 Đầu tiên chèn header cho văn bản:  

- Bước 1. Bạn kích đúp vào phần đầu trang, Word sẽ chuyển trạng thái cho bạn 

nhập nội dung vào header  

- Bước 2. Bạn nhập nội dung vào và sau khi kết thúc bạn kích ra bên ngoài  

 Tiếp theo chèn footer có nhiều cách, ở đây giới thiệu 1 cách:  

- Bước 1. Bạn chọn lệnh Insert > Page Number > Bottom of Page  

Trong danh mục các mẫu footer bạn chọn kiểu Accent Bar 2 như hình sau:  
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Khi đó footer của văn bản được chèn vào như sau:   

 

- Bước 2. Chỉnh sửa nội dung footer theo ý muốn  

Sau khi chèn footer bạn kích chuột vào trước số 1, rồi dùng phím Backspace xóa 

2 lần thì chữ 1|Page sẽ về bên lề trái như hình sau :  

 

Bạn nhập nội dung Nguồn Công ty CP Giá Xây Dựng https://gxd.vn vào, sau đó 

ấn phím Tab 2 lần sẽ được như ý. Để kết thúc bạn kích ra ngoài vùng văn bản.  

17.  Dùng điều khiển paragraph thụt đầu dòng  

Bạn để ý ở trong văn bản có thước ngang và thước dọc ở trên và bên trái màn 

hình soạn thảo.  

  

  

  

https://gxd.vn/
https://gxd.vn/
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Bạn để ý thấy có công cụ điều khiển indent (lề) của văn bản. Cách đơn giản nhất 

là như này: Bạn kích vào 1 đoạn text, sau đó đưa trỏ chuột lên đó và kéo từng nút 

công cụ indent sang trái, sang phải để thấy sự thay đổi, từ đó rút ra kinh nghiệm để 

điều khiển.  

 Bạn để ý như trong hình chụp dưới đây, có 3 công cụ để điều khiển lề của văn 

bản. Riêng vị trí số 1 và 3, bạn để trỏ chuột vào chỗ giao nhau giữa vùng trắng và 

vùng nâu sẫm thấy trỏ chuột biến thành mũi tên 2 chiều, kích giữ và kéo sang trái, 

phải sẽ tăng giảm lề cả văn bản. Kéo công cụ 2 thì sẽ thò thụt đầu dòng.  

 

 

 

 

 

 

 18. Copy ảnh trên màn hình vào Word 

Bạn cần 1 phần mềm chụp ảnh, và bạn thực hiện tượng tự với Excel, AutoCad 

và các phần mềm GXD. Ví dụ: Khi bóc tách khối lượng từ 1 cấu kiện, bạn có thể chụp 

hình và dán luôn vào trong Dự toán GXD để bóc tách nhập số liệu luôn mà đỡ phải 

chuyển qua lại màn hình.  

Thành thạo kỹ năng này giúp bạn soạn thảo giáo trình, báo cáo thuyết minh...  

có các hình minh họa đẹp, mà thao tác rất nhanh.  

18.1.  Dùng ngay phím PrtScr trên bàn phím  

- Nếu bạn cần chụp toàn bộ màn hình, bạn phấm phím PrtScr trên bàn phím, sau 

đó vào Word kích nút Paste, hoặc kích chuột phải chọn Paste, hoặc đơn giản là bấm 

Ctrl + V để dán nội dung.  

- Nếu bạn cần chụp 1 hộp thoại, bạn mở hộp thoại đó lên, giữ Alt và bấm PrtScr, 

sau đó quay vào Word và Paste. Ví dụ ở đây tôi chụp hộp thoại Tùy chọn của phần 

mềm Dự toán GXD. Rất nhanh và đơn giản:  
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18.2.  Dùng phần mềm chụp ảnh màn hình  

Để chụp ảnh một khu vực trên màn hình và dán vào Word, có rất nhiều phần 

mềm để bạn lựa chọn. Tôi hay dùng ShareX, bởi nó miễn phí mà rất tốt, rất nhiều 

chức năng và cũng thường xuyên cập nhật. Bạn có thể tải ở địa chỉ: 

https://getsharex.com.  

Bạn không nên dùng phần mềm crack, ví dụ SnagIt, hãy mua ủng hộ để người 

ta còn có tiền phát triển tiếp. Nhất là Kỹ sư càng phải tôn trọng điều này, bởi mình 

cũng làm ra sản phẩm, mình sẽ thấm nỗi đau khi ai đó dùng sản phẩm của mình bất 

hợp pháp. Điều này cũng liên quan đến đạo đức nghề nghiệp ngữa. Nếu không mua, 

hãy dùng kỹ năng giá trị thay thế (Value Engineering) tìm các giải pháp thay thế, giảm 

chi phí mà vẫn hiệu quả, không vi phạm pháp luật. Như tôi dùng ShareX ở trên là 1 

ví dụ, có vô số các phần mềm miễn phí mà vẫn rất tốt, hãy chịu khó tìm tòi.  

19.  Căn chỉnh hình ảnh, copy hình ảnh vào minh họa  

Bạn có thể Google để tìm và cài các phần mềm chụp ảnh. Có rất nhiều phần 

mềm hỗ trợ chụp ảnh màn hình:  

- Chuyên nghiệp thì có thể dùng SnagIt. Nhưng đây là phần mềm trả phí, nếu bạn 

dùng hãy ủng hộ tác giả, hãy nói không với crack nhé.  

https://getsharex.com/
https://getsharex.com/
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- Nếu bạn bạn muốn dùng bản miễn phí nhưng mà tốt thì cũng có rất nhiều phương 

án thay thế. Ví dụ tôi dùng sharex, thoải  mái chức năng để xài, bạn có thể tải bản cài 

ở đây https://getsharex.com. Rất dễ dùng, tải xuống rồi có thể đặt phím tắt, tôi đặt lài 

bấm PrtScr chụp cả màn hình, Alt+PrtScr là chụp cả màn hình, Ctrl+PrtScr là chụp 

vùng mình sẽ khoanh. Sau khi chụp xong ảnh thì dán vào Word. - Nhẹ nhàng, đơn 

giản nhưng chỉ có các chức năng cơ bản thì bạn dùng phần mềm LigthShot tải bộ cài 

ở đây https://app.prntscr.com. Sau khi cài xong thì có biểu tượng hình cái lông ngỗng 

(hay lá liễu gì đó) ở khay đồng hồ, bạn có thể kích trái/kích phải vào đó để đặt các 

tùy chọn phù hợp. Thế là chụp và dán vào Word.  

Sau khi dán vào Word, bạn kích phải vào ảnh sẽ có các chế độ ảnh nằm trên/dưới 

text, cùng hàng với text, text bao quanh… để tùy bạn chọn.  

Trong Word bạn cần chú ý :  

- Bạn nên chọn Styles Hình ảnh cho các ảnh và ghi chú về ảnh.  

- Kích phải vào ảnh bạn dùng các lệnh trong mục Wrap text để trình bày ảnh.   

  

 

Bài tập: Thực hành copy 1 ảnh trên Google hoặc Facebook và dán vào Word, 

chọn nằm cùng hàng với text.  

Với bài tập này bạn thực hành như sau.  

Bước 1. Bạn lên Google hoặc Facebook tìm 1 ảnh bất kỳ kích phải chọn Copy 

image  

Trên Facebook bạn có thể tìm ảnh của mình hoặc của bạn bè bất kỳ.  

Lệnh wraptext trên menu chuột phải :      

  

https://getsharex.com/
https://getsharex.com/
https://app.prntscr.com/
https://app.prntscr.com/
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Bước 2. Dánh ảnh vào Word  

 Bạn vào Word và chọn Paste có thể bạn sẽ không dán được ảnh. Bạn phải chọn 

Paste / Paste Special… trong hộp thoại hiện ra bạn chọn bitmap và bấm OK.   

  

Bước 3. Kích trái vào ảnh và chọn Styles Hình ảnh  

Bước 4. Kích phải vào ảnh và chọn Wrap text > Inline with text  

20.  Copy ảnh từ Intertnet vào Word  

Hãy mở Word ra và thực hành ngay nhé, nếu 1 lần chưa nhớ thì làm vài lần cho 

thật thuộc:  

Bước 1. Bạn mở trình duyệt, ví dụ: Chrome  

Bước 2. Tìm kiếm ảnh mà mình cần, kích phải vào chọn Copy Image  

Bước 3. Trở lại Word chọn Paste Special  

Bước 4. Trong hộp thoại mở ra bạn chọn Bitmap để dán vào Word  
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Hãy chú ý ảnh có bản quyền. Không nên vi phạm bản quyền. Hãy Google các 

trang web chia sẻ ảnh miễn phí, bạn sẽ tìm thấy rất nhiều trang web chia sẻ các ảnh 

đẹp miễn phí, người ta cho phép bạn sử dụng vào mục đích thương mại hoặc cá nhân 

tùy ý.  

21.  Trình bày sơ đồ SmartArt  

Trong Word bạn chọn lệnh Insert > SmartArt:  

 

Trong hộp thoại Choose a SmartArt Graphic hiện ra cuộn tìm dạng sơ đồ bạn 

mong muốn và bấm OK để chèn sơ đồ vào văn bản:  
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Khi sơ đồ chèn vào trong văn bản, bạn có thể đưa thêm nội dung hoặc chèn thêm 

các nhánh sơ đồ. Để định dạng toàn bộ sơ đồ hoặc từng phần từ bên trong, bạn kích 

vào rồi chọn công cụ trên menu Format hiện ra:  

 

Bài tập: Bạn hãy thực hành ngay việc trình bày sơ đồ sau đây, qua đó hiểu dần 

về cơ cấu tổ chức bộ máy công ty, hiểu về chi phí quản lý doanh nghiệp phải tốn cho 

bộ máy như nào và nếu bạn là nhân viên thì ngoài tiền lương cho bản thân bạn sẽ còn 

phải tạo ra giá trị để đóng góp vào chi phí quản lý như nào.  
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Giám đốc 

  

  

 

Phó giám đốc 

 

 

 

       

Trưởng phòng 
Kỹ thuật 

  
Trưởng phòng 

Kế hoạch 

  
Trưởng phòng 

Kinh tế 

  Trưởng 
phòng  

R&D 

    

22.  Đồ họa trong Word  

Bạn sử dụng công cụ Insert > Shapes, chọn các hình để vẽ theo ý muốn, sau đó 

bạn kích vào hình văn bản và kéo chuột để vẽ các khối hình. Để trình bày, định dạng 

bạn cũng chọn khối hình bạn chèn vào và chọn các lệnh trên menu Format tương tự 

như trên.   
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Sau khi vẽ xong, bạn có thể kích chọn đối tượng và giữ Ctrl rồi kích chuột kéo 

thả sang bên cạnh để nhân bản các khối hình giống nhau, giữ đồng thời để Ctrl+Shift 

và kéo thả để nhân bản thẳng hàng. Khi muốn phân phối đều hãy dùng lệnh Format > 

Align > Distribute, dùng lệnh này bạn đỡ phải đi gióng các đối tượng cho đều.  

   

Để cho thuận thiện sắp xếp các đối tượng đồ họa trong văn bản, bạn có thể nhóm 

chúng lại thành đối tượng duy nhất bằng cách: Chọn tất cả các đối tượng, sau đó dùng 

lệnh Format > Group > Group. Bạn có thể dùng linh hoạt uyển chuyển lệnh Group, 

Ungroup và Regroup khi cần chỉnh sửa các đối tượng.  

23.  Thay thế nội dung trong Word (Replace và Replace All)  

Ở phần này tôi sẽ chia sẻ với bạn cách ứng dụng lệnh Replace để thực hiện 1  
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số công việc rất nhanh và thú vị. Từ nền tảng đó bạn ứng dụng rộng ra và linh 

hoạt cho các tình huống khác.  

Tôi từng thấy nhiều tài liệu rất dài, trong đó các bạn soạn thảo rất "lổn nhổn", 

nhiều chỗ có 2 dấu cách, nhiều chỗ có 3 dấu cách hoặc dấu ": với dấu "," để rất lung 

tung… người kém kinh nghiệm nhìn vào thì không thấy gì, nhưng người chuyên 

nghiệp liếc mắt qua có thể người ta không nói gì, nhưng người ta đã nghĩ thầm trong 

bụng để đánh giá về sự kém của người soạn thảo văn bản.  

Bài tập 1: Bạn biên tập 1 tài liệu thấy các khoảng trống thừa rất nhiều. Hãy sửa 

lỗi trong tài liệu đó.  

Để tìm tất cả những chỗ thừa dấu cách đó để xóa bớt đi thì rất mất thời gian và 

là một công việc buồn tẻ, nhàm chán. Rất may bạn có thể làm rất nhanh và thú vị như 

sau:  

Bước 1. Bấm Ctrl + H để mở hộp thoại Replace  

Bước 2. Gõ 2 dấu cách vào ô trên  

Bước 3. Gõ 1 dấu cách vào ô dưới  

Bước 4. Bấm Replace All  

  

Bài tập 2: Tôi đang biên tập tài liệu "Cẩm nang nghiệm thu hoàn công, ứng 

dụng phần mềm QLCL GXD", trong tài liệu đó có rất nhiều chữ "Câu hỏi:" và "Trả 

lời:". Bạn hãy Replace tất cả thành bôi đậu và có gạch chân "Câu hỏi:" và "Trả lời:"  

 Thực hiện bài tập này dễ thôi, bạn làm tương tự như bài tập trên cho chữ "Câu 

hỏi", nhưng ở đây bạn kích vào Replace with và thêm định dạng gạch chân cho nó 

trong Format > Font, rồi bấm vào Replace All hoặc Replace lần lượt. Lặp lại tương 

tự với chữ "Trả lời".  
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Bạn có thể ứng dụng thủ thuật này cho việc sửa lỗi hàng loạt cho nhiều nội dung 

khác.  

24.  Tách bảng và chuyển đổi từ bảng sang đoạn text  

Để tách bảng bạn chọn vị trí muốn tách bảng và chọn lệnh Layout > Split table, 

để đổi toàn bộ bảng sang đoạn text ta dùng lệnh Layout > Convert to Text. Menu 

Layout chỉ hiện ra khi bạn chọn vào bảng. 

 

Bài tập thực hành: Hãy mở ngay Word ra, nhập dữ liệu vào và tình bày bảng 

dưới đây. Giả sử sau đó chúng ta muốn tách 4 dòng đầu ra khỏi bảng và chuyển thành 

đoạn text thông thường, còn phần dưới thì giữ nguyên. Cách thức là:  

Bước 1. Kích vào dòng sẽ ở lại làm tiêu để của bảng (kích vào ô Mã hiệu đơn 

giá) và chọn lệnh Split Table  

Bước 2. Kích chọn bảng trên đã tách ra và chọn Convert to Text để biến thành 

đoạn text 

 BẢNG PHÂN TÍCH ĐƠN GIÁ CHI TIẾT  
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 CÔNG TRÌNH: TRỤ SỞ CÔNG TY CP GIÁ XÂY DỰNG 

 HẠNG MỤC: VĂN PHÒNG SỐ 124, NGUYỄN NGỌC NẠI,  

THANH XUÂN, HÀ NỘI  

                       
ĐVT:  

đồng  

STT  

MÃ  

HIỆU  

ĐƠN 

GIÁ  

MSVT  

TÊN CÔNG VIỆC /  

THÀNH PHẦN 

HAO PHÍ  

ĐƠN  

VỊ  

ĐỊNH  

MỨC  

HAO PHÍ  

ĐƠN  

GIÁ  

VẬT TƯ  

  
THÀNH 

TIỀN  

[1]  [2]  [3]  [4]  [5]  [7]  [8]    [10]  

1  AB.25112     

Đào móng công 

trình, chiều rộng 

móng <=6 m, bằng 

máy đào <=0,8 m3,  

đất cấp II  

100m3             

         Nhân công     1       1.167.480  

      N1307  
Nhân  công  3,0/7  

(nhóm 1)  
công  6,11  191.077    1.167.480  

         Máy thi công     1       952.615  

      M0006  Máy đào 0,8m3  ca  0,372  2.560.793    952.615  

  

25.  Cắt di chuyển dòng / cột trong bảng  

Chỉ việc để trỏ chuột ở vị trí bên trái ngoài lề để kích chọn được dòng hoặc ở 

trên đỉnh cột để chọn được cả cột.  

Sau đó bấm Ctrl + X để cắt.  

Tiếp theo đánh dấu vị trí cần chuyển đến (cả dòng hoặc cả cột) bấm Ctrl + V. 

Lưu ý là ở đây có thể bạn sẽ sợ là khi Ctrl + V sẽ đè nội dung lên dòng hay cột bị 

đóng dấu. Nhưng không ! Nếu mình đánh dấu cả dòng và cột thì Ctrl + V sẽ thực hiện 

chèn vào vị trí đó mà không đè lên. Nắm bắt được thao tác này thì trình bày bảng rất 

nhanh.  

Bài tập: Bạn hãy tìm 1 cái bảng dữ liệu bất kỳ trong Word và thực hành ngay 

thao tác này để nắm bắt vấn đề.  

26.  Copy căn cứ, cơ sở pháp lý vào tài liệu Word  
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26.1.  Khi làm hồ sơ dự án, dự toán, dự thầu  

Chẳng hạn khi bạn đang soạn trên Word báo cáo thuyết minh dự toán hoặc thẩm 

tra dự toán, bạn cần chép các căn cứ, cơ sở pháp lý. Trong tay bạn có phần mềm Dự 

toán GXD, bạn thực hiện như sau :  

1. Mở phần mềm Dự toán GXD  

2. Bấm Ctrl+Shift+F, gõ tên văn bản vào và tìm kiếm  

3. Chọn tên văn bản (có thể giữ Ctrl chọn nhiều) và bấm Ctrl+C  

4. Trở lại cửa sổ Word đang soạn thảo bấm Ctrl+V để đưa tên văn bản vào vị  

trí   

26.2.  Khi làm Hồ sơ chất lượng, nghiệm thu chất lượng  

Khi viết biên bản xử lý hiện trường, báo cáo, thuyết minh, biện pháp,... cần dẫn 

chứng các cơ sở pháp lý thì cứ phải lên mạng search rồi copy về sửa, nó lại kèm theo 

mã html nên paste vào Word xấu. QLCL GXD cập nhật chức năng trong hộp thoại 

Thư viện tài liệu. Muốn copy căn cứ, chỉ việc Ctrl + Shift + F, gõ tên văn bản và Ctrl 

+ C. Sau đó quay sang Word rồi paste vào. Các tên văn bản được biên soạn chuẩn 

Styles GXD. Quy trình thực hiện:  

Mở phần mềm QLCL GXD và Word viết báo cáo  

Cần tên văn bản, tiêu chuẩn hoặc quy chuẩn, bấm Ctrl+Shift+F, gõ tên vào và 

tìm kiếm  

Bấm chọn văn bản tìm được, Ctrl + C  

Ví dụ trong hình thực hiện copy tên Thông tư số 26/2016/TT-BXD để dán vào 

tài liệu Nhật ký thi công.  
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4. Alt + tab để chuyển đổi cửa sổ sang Word bấm Ctrl + V  

  

Cập nhật QLCL GXD: Mở phần mềm, bấm Trợ giúp > Thông tin phần mềm > 

Cập nhật và trải nghiệm.  

27.  Chuyển đổi Pdf sang Word  

Có nhiều trường hợp bạn chỉ có file Pdf, bạn muốn chuyển dữ liệu sang file Word 

để chỉnh sửa, biên tập hoặc sao chép một số nội dung. Bạn có thể thực hiện theo cách 

đơn giản như sau:  

Bước 1. Truy cập một trong các trang web  

https://ilovepdf.com  

https://www.ilovepdf.com/
https://www.ilovepdf.com/
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https://pdf2doc.com 

 https://freepdfconvert.com  

https://smallpdf.com  

Bước 2. Trên trang web đó có nút cho bạn Browse đến tài liệu  

Bước 3. Bạn up lên, chờ 1 chút rồi tải file đã chuyển đổi về  

Có rất nhiều trang web cho phép chuyển đổi, có trang miễn phí, có trang thu phí 

và chính sách thay đổi tùy thời gian. Nhiều trang miễn phí rất tốt, bạn phải chịu khó 

thử. Google từ khóa Pdf to Word luôn là giải pháp tốt.  

Hãy chú ý về tính bảo mật của tài liệu nhé. Tôi chưa nghiên cứu về việc các 

trang web trên có thu thập file up lên của mình vì mục đích gì không. Vì đa số tài liệu 

tôi up lên để chuyển đổi không quá nhạy cảm về tính bảo mật.  

28.  In Word sang file Pdf  

Tôi nghe 1 số người bạn đã làm việc ở các nước phát triển như Mỹ, Singapore 

với bản vẽ xây dựng họ làm việc với nhau bằng file Pdf là chính. File Pdf có những 

cái lợi như:  

- Khi bạn dùng file Word, gửi từ máy tính này sang máy kia để in có thể bị nhảy 

xô lệch định dạng, chuyển sang Pdf sẽ giải quyết được vấn đề.  

- Bảo vệ bản quyền không cho phép chỉnh sửa.  

- .v.v.  

Để thực hiện đưa 1 file Word sang Pdf rất là đơn giản, bạn thực hành luôn nhé:  

Bước 1. Bạn tạo 1 file Word mới và nhập đoạn sau vào  

Hầu hết chúng ta học cách xử lý tiền bạc từ cha mẹ mình, và thường thì người 

nghèo không dạy con về tiền bạc mà chỉ nói đơn giản là: “Hãy đến trường và học 

cho chăm chỉ.” Và rồi đứa trẻ có thể sẽ tốt nghiệp với một số điểm xuất sắc nhưng 

với một đầu óc nghèo nàn về cách quản lý tiền bạc, vì trường học không dạy về chuyện 

tiền nong mà chỉ tập trung vào việc giáo dục sách vở và những kỹ năng nghề nghiệp 

mà không nói gì về kỹ năng tài chính.  

Đó chính là lý do tại sao những nhân viên ngân hàng, bác sĩ, kế toán thông minh 

dù đạt được nhiều điểm số xuất sắc ở trường nhưng lại gặp nhiều rắc rối tài chính 

suốt đời.  

Và những món nợ quốc gia chóng mặt thường bắt nguồn từ những vị lãnh đạo 

có học vấn cao, nhưng chỉ được huấn luyện rất ít hoặc không có chút kỹ năng nào về 

vấn đề tài chính.  

Bước 2. Chọn Save as hoặc Print để xuất tài liệu ra dạng file Pdf 

https://pdf2doc.com/
https://pdf2doc.com/
https://pdf2doc.com/
https://freepdfconvert.com/
https://smallpdf.com/
https://smallpdf.com/
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 Nếu chọn Save as trong hộp thoại mở ra bạn chọn loại file Save là Pdf  

 

- Lưu ý: 

- Với các phiên bản Word 2013, 2016 trở di có hỗ trợ tính năng Save as ra file Pdf 

luôn.  

- Với các phiên bản Word đời cũ hơn thì có thể bạn phải cài thêm tiện ích bổ sung 

của Microsoft.  

 Nếu chọn Print, thay vì chọn máy in ra giấy bạn chọn máy in Pdf 

- Với các phiên bản Word đời cao có hỗ trợ luôn lựa chọn Microsoft Print to PDF.  

- Với các phiên bản Word đời cũ, bạn có thể cài thêm tiện ích của bên thứ 3, ví dụ 

có tiện ích miễn phí mà tốt tôi hay dùng là DoPdf. Cài tiện ích này thì có hỗ trợ cả 

các phần mềm khác máy in ảo Pdf như in bản vẽ AutoCad, Revit…  
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29. Chổi định dạng Format Painter 

Khi muốn sao chép định dạng từ một nguồn sang nhiều chỗ, bạn chọn nguồn, 

sau đó kích đúp vào công cụ Format Painter, rồi kích vào đích để sao chép định dạng.  

Nhớ là kích đúp nhé, kích 1 lần thì chỉ dùng được 1 lần thôi.  

Hoặc kết hợp 2 tay, tay phải đưa chuột ra lề trái kích chọn nguồn tay trái bấm 

Ctrl+Shift+C, sau đó kích chọn đích và Ctrl+Shift+V.  

Thực hành nhé: Hãy sao chép định dạng dùng Format Painter cho ví dụ dưới đây 

sao cho công việc nhanh và thú vị hơn.  

 Ví dụ: bạn gõ ra đoạn chữ này và định dạng nó nghiêng, đậm, màu đỏ và 

dùng bullet là dấu tròn. (đây là nguồn)  

Tiếp theo bạn gõ thêm đoạn đích dưới đây và sao chép định dạng ở nguồn cho 

các đoạn đích:  

Người nghèo làm việc vì tiền bạc. (đích)  

Người giàu buộc tiền bạc phải làm việc cho mình. (đích)  

Nếu bạn muốn học để làm việc vì tiền, hãy học ở trường. Còn nếu muốn học 

cách buộc tiền bạc phải làm việc cho mình, thì phải học thêm từ bên ngoài, từ những 

người thành công, nhƣng chỉ khi bạn thực sự muốn học. (đích)  

- Đọc sách mà không áp dụng cũng giống như ăn uống mà không tiêu hóa, một 

bên là thừa chất mỡ máu tiểu đường gout, một bên là bội sách. (đích)  
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30. Lặp lại các thao tác gộp bằng phím F4 

Khi phải thực hiện định dạng nhiều thuộc tính cho 1 đoạn văn bản hoặc đối tượng 

trong Word, sau đó phải lặp lại cho nhiều đoạn hoặc đối tượng khác thì ta dùng phím 

F4.  

Ví dụ: Để trình bày tất cả các ảnh trong văn bản theo Styles GXD là Hình ảnh. 

Bạn sẽ theo chiến lược là trình bày hết 1 lượt từ trên xuống dưới văn bản: chọn hình 

ảnh đầu tiên, áp Styes Hình ảnh cho nó, sau đó cuộn văn bản, 1 tay bạn kích vào ảnh 

tiếp theo, 1 tay ấn F4… cứ vậy cho đến hết.  

Bài tập: 

Bước 1. Bạn mở Word ra, nhập nội dung sau và trình bày   

Quy Tắc Thịnh Vượng số 1: Thu nhập của bạn chỉ có thể tăng lên theo mức 

độ mà bạn mong đợi!  

Bước 2. Định dạng Nghiêng, Đậm, chữ màu Đỏ cho đoạn đó  

Trường hợp này bạn đừng dùng các công cụ lẻ, hãy đưa trỏ chuột ra ngoài lề 

phải đánh dấu cả đoạn trên, rồi kích vào nút mở hộp Font (xem hình) hoặc bấm Ctrl+D, 

trong hộp thoại hiện ra chọn các thông số Bold, Italic và màu đỏ.  

  

Bước 3. Đưa trỏ chuột ra đầu lề phải kích chọn các đoạn còn lại và ấn F4.  

- Quy Tắc Thịnh Vượng số 2: Nếu bạn muốn thay đổi hoa trái, bạn phải thay đổi 

gốc rễ trước đã. Nếu bạn muốn thay đổi cái hữu hình, trước hết bạn phải thay đổi cái 

vô hình.  

- Quy Tắc Thịnh Vượng số 3: Tiền bạc, của cải, sức khỏe, bệnh tật đến cân nặng 

cũng là kết quả của chế độ dinh dưỡng và lối sống của bạn. Chúng ta sống trong một 

thế giới nhân quả.  



Ứng dụng Word + Quản lý dự án GXD quản lý hồ sơ dự án xây dựng  

Nguồn Công ty CP Giá Xây Dựng https://gxd.vn  61 | P a g e  

  

- Quy Tắc Thịnh Vượng số 4: Suy nghĩ sinh ra Cảm xúc, Cảm xúc đưa đến Hành 

động, Hành động tạo ra Kết quả.  

- Quy Tắc Thịnh Vượng số 5: Khi tiềm thức phải lựa chọn giữa một bên là những 

cảm xúc để bám rễ sâu xa và một bên là tính hợp lý thì hầu như cảm xúc bao giờ cũng 

thắng.  

- Quy Tắc Thịnh Vượng số 6: Nếu động cơ kiếm tiền hay thành công của bạn xuất 

phát từ những nguyên nhân không tích cực như sợ hãi, giận dữ, hay nhu cầu chứng tỏ 

bản thân th. tiền bạc sẽ không bao giờ mang lại cho bạn cảm giác hạnh phúc.  

- Quy Tắc Thịnh Vượng số 7: Cách duy nhất để thay đổi một cách ổn định nhiệt 

độ trong phòng là cài đặt lại nhiệt kế tự động của máy điều hòa. Cũng thế, cách duy 

nhất để thay đổi mức độ thành công tài chính của bạn một cách bền vững là cài đặt 

lại "nhiệt kế tài chính" trong tâm thức bạn.  

31.  Xử lý dữ liệu qua lại giữa Word và Excel  

Đây là 1 kỹ năng xử lý dữ liệu, nếu bạn nắm bắt được thì khi cần thiết bạn có 

thể ứng dụng vào công việc rất tốt.  

Ví dụ: Tôi có dãy họ tên và số điện thoại của nhân viên GXD kinh doanh và 

tuyển sinh như dưới đây. Giờ tôi muốn copy đưa sang Word và chia cột, chia dòng.  

Ms Thu An, 0974 889 500, đăng ký Lớp học Quản lý chất lượng GXD  

Ms Huyền Thanh, 0985 099 938, đăng ký mua phần mềm QLCL GXD  

Bây giờ tôi muốn đưa dữ liệu nói trên sang bảng Excel và phân vào 3 cột, 2 dòng 

với tiêu đề cột Họ tên, SĐT, Phụ trách thì làm thế nào? Ở đây chỉ có 2 bản ghi thôi 

nhé, với các dữ liệu hàng nghìn bản ghi thì việc xử lý thủ công có khi mất cả tháng, 

cả năm nhập lại dữ liệu.  

Bạn mở Word, Excel thực hành ngay như sau sẽ rất nhanh chóng:  

Bước 1. Đánh dấu dữ liệu bên Word  

  

Bước 2. Chọn Insert > Table > Convert Text to Table  

Lệnh này cho phép chuyển đổi nhanh từ Chữ (Text) vào các Bảng (Table)  
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Bước 3. Trong hộp thoại hiện ra bạn chọn định dạng phân cách bởi dấu phẩy ở 

mục Other và chọn Number of columns là 3 cột, dữ liệu sẽ tự phân vào bảng  

  

Bước 4. Bạn copy sang Excel, thêm tiêu đề bảng và trình bày cho đẹp  

Ở đây để trình bày ngắn gọn tôi trình bày 2 dòng. Trường hợp bạn có 1 triệu 

dòng dữ liệu thì cũng như vậy. Quá nhanh và quá nguy hiểm phải không nào.  

32.  Mailings trộn thư  
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Đây là chức năng mà dân văn phòng hoặc kỹ sư QS, QA/QC xây dựng rất hay 

ứng dụng. Tưởng tượng: Mẫu thiệp mời có rồi, thời gian địa điểm rõ ràng. Lại một 

đám mừng ở trong làng. Ngó danh sách bỗng dưng thấy hoang mang. Rồi ngày cưới 

rộn ràng khắp vùng… Giả sử bạn cần điền lần lượt tên 500 anh em trong danh sách 

vào chỗ trống trong mẫu thiệp mời. Mailing sẽ giúp bạn điều này.  

Bước 1. Dùng Word chuẩn bị mẫu thiệp mời, để chừa ra chỗ trống điền tên  

Bước 2. Dùng Excel nhập danh sách tên những người cần mời  

Bước 3. Dùng chức năng Mailings để trộn danh sách Excel và file Word tự động 

nhân bản ra hàng loạt thiệp mời với tên được thay đổi tự động  

Xa rồi cái thời mời 500 anh/em, phải nhân ra 500 bản rồi nhập tên 500 người.  

Tương tự như vậy, khi làm biên bản nghiệm thu xây dựng của hàng trăm đầu 

việc. Mẫu biên bản cũng như mẫu thiệp mời, cần thay tên và thông tin của các công 

tác vào chỗ trống.  

 

Tuy nhiên, trong xây dựng yêu cầu nhiều hơn, nhiều dự án yêu cầu nhiều thông 

tin hơn, nên tính năng trộn thư Mailings không đáp ứng được các yêu cầu phức tạp. 

Phải dùng phần mềm Quản lý chất lượng GXD ứng dụng sự phát triển của công nghệ 

đáp ứng yêu cầu ngày càng cao, nhu cầu ngày càng nhiều của con người. Điều hay là 

có thể sử dụng cả phần mềm QLCL GXD và Mailings để bọc lót ưu/khuyết thành giải 

pháp cho công việc hoàn hảo.  

Bài tập. Bạn hãy tải bộ file mẫu: link. Hãy thực hiện trộn dữ liệu để tạo phiếu 

yêu cầu (PYC) và biên bản nghiệm thu vật liệu cát (BBNT) về công trường.   

Sau khi tải file về và giải nén ra, bạn sẽ thấy có 2 file:  

1) File Word có tên … là file chứa biểu mẫu PYC và BBNT. Các nội dung 

là thống nhất, fix cứng được để trong biểu mẫu.  

File này ban đầu chỉ có 2 trang là biểu mẫu.  

2) File Excel chứa dữ liệu về vật liệu cát. Các thông tin này là động, sẽ lần lượt 

được điền tự động vào file Word biểu mẫu nói trên.  

Trong file này có 5 bản ghi trong sheet VLXD là thông tin cần điền vào chỗ 

trống ở 2 trang biểu mẫu nói trên.  
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 Thực hiện trộn tạo ra biên bản riêng cho 5 bản ghi vật liệu:  

Bạn mở file Word lên, dùng lệnh Mailings > Select Recipients > Step-by-Step  

Mail Merge Wizard…  

 

Sau đó bạn thực hiện theo trình tự 6 bước như sau:  

Bước 1. Bạn kích vào Next: Starting document  

  

Bước 2. Chọn Use the content document  

Rồi chọn Next: Select recipients  
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Bước 3. Chọn dữ liệu nguồn  

Bạn kích vào Brows… ở khung Mail Merge ở phía phải  

 

Trong hộp thoại hiện ra bạn trỏ đến file Excel nguồn dữ liệu. Vì trong file Excel 

có nhiều sheet (tôi để ẩn), nên ta phải chỉ ra dữ liệu của mình ở sheet VLXD:  
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Sau đó bấm OK. Trong hộp thoại hiện ra tiếp theo bạn cũng cứ bấm OK.  

Rồi bấm tiếp vào Next: Write your letter:  

  

Bước 4. Bạn bấm tiếp Next: Preview your letters  

  

Bước 5: Bạn có thể bấm vào các nút để xem trước các biên bản  
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Sau đó bấm vào Next: Complete the merge.  

Bước 6: Bạn bấm vào Edit individual letters… để chọn các biên bản  

 

Trong hộp thoại hiện ra bạn chọn All để trộn tất cả các bản ghi xuất ra biên bản 

hoặc chọn Current record để xuất biên bản của bản ghi hiện thời hoặc trong From bạn 

chọn 2 to 2 để xuất biên bản của bản ghi số 2.  

  

Nếu thấy khó hiểu bạn hãy đóng file lại và thực hiện đi thực hiện lại vài lần,  
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voọc đại đi sẽ hiểu vấn đề.  

Lời khuyên, những mẫu biên bản nào đại trà, bạn hãy dùng phần mềm QLCL 

GXD để tự động hóa. Những mẫu quá khác biệt không thể chế QLCL GXD tự động 

hóa được, bạn dùng thêm giải pháp Mailing này bọc lót là tròn bài.  

33.  Trình bày biên bản nghiệm thu  

Bạn đã đi sắp hết cuốn tài liệu này, đọc được đến đây là tốt rồi, tôi nghĩ bạn đọc 

và mở Word ra thực hành thao tác còn tốt hơn nữa. Nhưng đỉnh nhất phải là đọc xong 

phải áp dụng được vào công việc. Tôi đã làm được như vậy, mình đọc từ tài liệu, giáo 

trình xong sau đó khi làm việc mình luôn nhớ tới và tìm cách áp dụng luôn vào công 

việc. Cứ thế cứ thế, lâu dài phải thành thói quen, đọc sách là áp dụng được vào công 

việc và cuộc sống.  

Phần này tôi muốn bạn tăng tốc hơn 1 chút, có vô vàn mẫu biên bản, hồ sơ, tài 

liệu đã được chế bản chuẩn Styles GXD rồi, chúng ta không nên đi làm lại từ đầu nữa, 

cần từ đó kế thừa và sáng tác ra những cái mới.  

Bài tập: Yêu cầu bạn soạn Quyết định bổ nhiệm chỉ huy trưởng công trường.   

Bạn thực hiện như sau :  

Bước 1: Mở phần mềm QLCL GXD  

Bước 2: Bấm Ctrl+Shift+F để mở hộp thoại quản lý thư viện  

Bước 3: Gõ từ khóa tìm kiếm "chỉ huy trưởng"  

 

Bước 4: Kích phải vào biểu mẫu chọn Tải xuống và mở  

Bước 5: Chỉnh sửa nội dung cho phù hợp  

Bước 6: In ra, trình sếp ký, phát hành và lưu hồ sơ  

Như vậy, bạn không chỉ biết Word, mà còn kết hợp với các công cụ phần mềm 

khác để tìm kiếm tài liệu và hoàn thành nhanh nhiệm vụ nhanh, chính xác và chuyên 

nghiệp.  

34.  Chèn và cập nhật mục lục  
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Nếu bạn dùng Styles chuẩn GXD ngay từ đầu thì đến đây tạo mục lục như một 

khâu hưởng thụ thành quả vô cùng sung sướng. Kể cả có thêm bớt, chỉnh sửa gì tài 

liệu bị nhảy trang thì việc cập nhật mục lục cũng rất sướng.  

Để chèn mục lục, bạn chỉ việc chọn vị trí muốn đặt mục lục thường là đầu hoặc 

cuối tài liệu, rồi kích lệnh: References > Table of Contents và chọn một mẫu mục 

lục có sẵn.   

 

Để cập nhật mục lục, bạn chỉ việc kích phải vào mục lục rồi chọn Update.   
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CHƯƠNG 3: BÀI TẬP TỰ THỰC HÀNH 

1.  Bài tập 1 Vẽ sơ đồ sử dụng công cụ đồ họa  

Yêu cầu: Bài tập sau bạn vừa học Word vừa nắm về sơ đồ tư vấn theo trình tự 

dự án đầu tư xây dựng  

1. Sử dụng công cụ đồ họa trong Word, hãy trình bày sơ đồ dưới đây sao cho 

nhanh, đẹp và chuẩn nhất  

2. Tìm hiểu Nghị định về quản lý dự án và các quy định liên quan, điều chỉnh 

hoặc bổ sung thêm ?  

  

Bạn có thể chủ động vẽ rồi nghĩ ra cách vẽ nhanh, có cách vẽ sơ đồ trên rất 

nhanh trong Word, nếu bạn tự tìm ra rồi thì OK. Nếu không tìm ra, có dịp đến học 
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tại Công ty CP Giá Xây Dựng, tôi sẽ chỉ cho bạn cách thực hiện, rất nhiều điều thú 

vị. Bạn cũng có thể dùng bảng để trình bày hoặc vẽ bên AutoCad hoặc nhiều 

chương trình đồ họa rồi copy sang.  

2.  Bài tập 2 Trình bày bảng tổng hợp giá xây dựng công trình  

Yêu cầu: Hãy trình bày bảng phân tích đơn giá chi tiết của công trình như mẫu 

dưới đây, qua đó vừa luyện được kỹ năng Word, vừa nắm thêm về chuyên môn :  

cách tính toán và trình bày đơn giá xây dựng chi tiết của công trình.  

Bảng 3.3. TỔNG HỢP GIÁ XÂY DỰNG CÔNG TRÌNH  

Công trình: ...................................................................................................  

PHẦN ĐƠN GIÁ XÂY DỰNG CHI TIẾT CỦA CÔNG TRÌNH  

Stt. (Tên công tác xây dựng)  

Đơn vị tính: ...  
MÃ  

HIỆU   

ĐƠN 

GIÁ  

MÃ  

HIỆU      

VL, NC, 

M  

 THÀNH PHẦN      

HAO PHÍ  

ĐƠN  

VỊ  

TÍNH  

KHỐI 

LƯỢNG  

ĐƠN 

GIÁ  

THÀNH 

TIỀN  

[1]  [2]  [3]  [4]  [5]  [6]  [7]  

DG.1  
  Chi phí VL  

      
  

V.1            

V.2            

...            

  Cộng        VL  

  

Chi phí NC (theo 

cấp bậc thợ bình 

quân)  
công  

    

NC  

  Chi phí MTC          

M.1    ca        

M.2    ca        

...            

  Cộng        M  

  

3.  Bài tập 3 Trình bày bảng so sánh 2 loại đơn giá  

Yêu cầu: hãy trình bày bảng so sánh giữa đơn giá xây dựng cơ bản và đơn giá 

xây dựng tổng hợp dưới đây. Quan đó bạn vừa nắm thêm được kỹ năng Word về trình 

bày bảng, vừa hiểu thêm được 1 số vấn đề về đơn giá xây dựng.  

Sự khác nhau giữa ĐGxdcb và Đgxdth như sau  
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  Đơn giá xây dựng cơ bản  
Đơn giá xây dựng tổng 

hợp  

Mục đích  

yêu cầu  

- Lập dự toán và quyết toán vốn đầu 

tư và quản lý  chi phí xây dựng các 

hạng mục ở giai đoạn thiết kế bản vẽ 

thi công  

- Lập tổng dự toán và quản lý chi phí  

xây dựng công trình ở giai đoạn thiết 

kế kỹ thuật  

  - Phù hợp với giai đoạn thiết kế bản vẽ 

thi công và thanh quyết toán công trình  

- Phù hợp với giai đoạn thiết kế kỹ 

thuật (hoặc thiết kế kỹ thuật thi công)  

  - Xác định được hao phí lao động xã 

hội trung bình cần thiết  

- Đảm bảo được tính tổng hợp  

  - Giảm nhẹ được khối lượng tính toán 

khi lập dự toán  

- Thuận tiện cho sử dụng, giảm nhẹ 

khối lượng tính toán khi lập tổng dự 

toán  

Cơ sở  để 

tính toán  

- Dựa trên cơ sở định mức dự toán xây 

dựng cơ bản, bảng giá vật liệu đến 

hiện trường, giá nhân công, bảng giá 

ca máy, bảng cước vận tải hàng hóa  

(đường bộ, đường sắt , đường thuỷ, 

đường hàng không) lấy theo mặt bằng 

giá trên thị trường các văn bản hiện 

hành của Nhà nước hướng dẫn lập và 

quản lý giá xây dựng...  

-Dựa trên cơ sở định mức dự toán 

tổng hợp, đơn giá xây dựng cơ bản, 

bảng gía vật liệu đến  hiện trường, 

giá nhân công, bảng giá ca máy, 

bảng cước vận tải hàng hóa ( đường 

bộ, đường sắt, đường thủy, đường 

hàng không) lấy theo mặt bằng giá 

trên thị trường tại thời điểm lập đơn 

giá, các văn bản hiện hành của nhà 

nước hướng dẫn lập và quản lý giá 

xây dựng.  

  - Quy chuẩn, tiêu chuẩn, quy phạm xây 

dựng của Việt Nam  

- Quy chuẩn, tiêu chuẩn, quy phạm 

xây dựng của Việt Nam  

  - Biện pháp thi công phổ biến  - Biện pháp thi công chủ đạo.  

Nội dung  

- Đơn giá xây dựng cơ bản; xác định 

các chi phí (vật liệu, nhân công, máy 

thi công) để hoàn thành một đơn vị 

khối lượng công tác xây lắp riêng biệt 

bộ phận kết cấu xây lắp được chia ra 

một cách khá chi tiết trong điều kiện 

kỹ thuật đã được xác định và biện 

pháp thi công phổ biến.  

- Đơn giá xây dựng tổng hợp xác 

định các loại chi phí (vật liệu, nhân 

công, máy thi công) để hoàn thành 

một đơn vị khối lượng công tác xây 

lắp tổng hợp trong điều kiện kỹ 

thuật và biện pháp thi công ở mức 

độ mở rộng hơn đơn giá dự toán xây 

dựng cơ bản.  

Phạm vi sử 

dụng  

- Lập dự toán xây dựng cơ bản tổ giai 

đoạn thiết kế bản vẽ thi công, dùng để 

thanh quyết toán công trình  

- Lập tổng dự toán công trình ở giai 

đoạn thiết kế kỹ thuật, không được 

dùng để thanh, quyết toán công trình 

xây dựng  
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4.  Bài tập 4 Trình bày sơ đồ tổng quan hệ thống Định mức kinh tế kỹ thuật  

Yêu cầu: Trình bày sơ đồ tổng quan hệ thống Định mức như dưới đây. Qua đó 

nắm thêm về kỹ năng Word và nắm bắt thêm kiến thức về định mức kinh tế kỹ thuật 

hiện hành của Việt Nam.   

Bảng 2: Sơ đồ tổng quan hệ thống Định mức 

kinh tế kỹ thuật hiện hành của Việt nam 
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5.  Bài tập 5 Trình bày nội dung phương pháp xác định đơn giá xây dựng  

Yêu cầu: Dùng Style Word trình bày nội dung như dưới đây, qua đó nắm thêm 

kỹ năng về Word và hiểu thêm về trình tự xác định đơn giá xây dựng tổng hợp.  

Phương pháp xây dựng Đơn giá xây dựng 

  tổng hợp được xác định theo trình tự 

Bước 1:  Xác định danh mục công tác xây lắp, bộ phận kết cấu cần xây dựng 

Đơn giá xây dựng tổng hợp, một số chỉ tiêu kỹ thuật chủ yếu, đơn vị tính và nội dung 

thành phần công việc của nó.  

Bước 2: Tính khối lượng xây lắp (qi) của từng loại công tác xây lắp thứ i cấu 

thành nên Đơn giá xây dựng tổng hợp.  

Bước 3: áp dụng chi phí vật liệu (Vli), chi phí nhân công (NCi) chi phí máy thi 

công (mi) đã có sẵn cho từng công tác xây lắp thứ i trong Đơn giá xây dựng chi tiết 

hiện hành .  

Bước 4: Xác định chi phí vật liệu (VLi), chi phí nhân công (NCi), chi phí máy 

thi công (Mi), tương ứng với khối lượng xây lăp (qi), của từng loại công tác xây lắp 

thứ i, cấu thành nên Đơn giá xây dựng tổng hợp theo công thức.  

Vli = qi x Vli ;                 NCi = qi x NCi ;              Mi = qi x mi  

Bước 5: Tổng hợp kết quả theo từng khoản mục chi phí trong Đơn giá xây dựng 

tổng hợp theo công thức sau:  

 

Trong đó:  

  qi là khối lượng công tác xây lắp thứ i  

 vli là chi phí vật liệu công tác thứ i  

 nci là chi phí nhân công công tác thứ i  

 mi là chi phí máy thi công công tác thứ i  

 vli là chi phí vật liệu tương ứng với khối lượng xây lắp qi trong Đơn giá xây 

dựng tổng hợp.  

 NCi là chi phí nhân công tương ứng với khối lượng xây lắp qi trong Đơn giá 

xây dựng tổng hợp.  

 Mi là chi phí máy thi công tương ứng với khối lượng xây lắp, qi trong Đơn giá 

xây dựng tổng hợp.  

6.  Bài tập 6 Trình bày công thức với chỉ số trên và chỉ số dưới  

 

VL  

n  

; NC  

n  

; M  

n 

M i 

 

 ∑ VLi ∑ NCi ∑  
 i1    i1   i1   
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Bảng số 3: Công thức chung xác định đơn giá xây dựng 

tổng hợp (ĐGXDTH) cho loại công tác thứ i 

ĐGXDTH = [(VLi
TH+NCi

TH+MTCi
TH)+(NCi

TH. Ki
c)] (1+Ki

l)] (1+ Ki
t);  (2-1

)   

Hoặc:  

ĐGXDTH = [(VLi
TH+NCi

TH+MTCi
TH)+(1 + Ki

c)] (1+Ki
l)] (1+ Ki

t);   (2-2)  

Trong đó:  

- VLi
TH+NCi

TH+MTCi
TH; lần lượt là chi phí vật liệu, chi phí nhân công, chi phí 

máy thi công trong Đơn giá xây dựng tổng hợp của loại công tác xây lắp thứ i.  

- Ki
c: Hệ số tính đến chi phí chung cho loại công tác xây lắp thứ i.  

Nếu tính theo công thác (2-1) thì chi phí chung được tính bằng tỷ lệ % so với chi 

phí nhân công trong đơn giá .  

Nếu tính theo công thức (2-2) thì chi phí chung được tính bằng tỷ lệ % so với 

chi phí trực tiếp trong đơn giá.  

Ki
l, K

i
t. Hệ số tính đến thu nhập chịu thuế tính trước và thuế giá trị gia tăng đầu 

ra loại công tác xây lắp thứ i.  

7.  Bài tập 7 Hãy tìm mẫu Báo cáo thẩm định / thẩm tra dự toán và soạn thảo  

Trong phần mềm Dự toán GXD có biểu mẫu báo cáo thẩm định/thẩm tra dự toán, 

file Word, trình bày chuẩn Styles GXD. Bạn mở phần mềm ra, bấm Ctrl+Shift+F, gõ 

từ khóa thẩm định hoặc thẩm tra để tìm, tải xuống mở ra và thực hiện công việc. Yêu 

cầu thời gian chỉ 2 phút phải hoàn thành.  

8.  Bài tập 8 Kết hợp Word và Excel trong xử lý và trình bày bảng dữ liệu  

Trong bài này bạn sẽ học Word, Excel kết hợp để hoàn thành 1 nhiệm vụ và cũng 

phát triển tư duy làm việc nhanh, phong cách làm việc chuyên nghiệp.  

Bạn tải bài tập Word là các câu hỏi trắc nghiệm Định giá xây dựng và Quản lý 

dự án xây dựng link dưới. Các nội dung trong Word này trình bày rất là dở, các bảng 

dữ liệu có nhiều lỗi, nhiều chỗ chưa đẹp, khi thực hiện trình bày lại bạn sẽ rất khó 

điều khiển. Cứ tải file xuống và trình bày lại những chỗ bạn thấy chưa ổn hoặc những 

bảng bị ngắt dở chừng và bạn sẽ thấy vấn đề.  

Link tải: https://bom.to/bai-thuc-hanh-Word-GXD   

Yêu cầu là bạn trình bày lại bảng biểu trong Word thật chuẩn. Giải pháp để làm 

nhanh ở đây là bạn copy toàn bộ dữ liệu sang Excel để trình bày, xử lý dữ liệu. Excel 

sẽ mạnh hơn về bảng và xử lý trình bày đồng loạt dữ liệu giống nhau. Sau đó copy 

trở lại Word và căn chỉnh bảng lại cho đẹp.  
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LỊCH SỬ CẬP NHẬT 

- Các tư liệu sưu tập cho khóa học Word xây dựng tại GXD và huấn luyện các bạn 

trẻ, những thực tập sinh tại GXD từ nhiều năm trước. Trên cơ sở đó giáo trình được 

dựng thành khung vào đầu năm 2019.  

- Tháng 10/2019 nhân lúc đang soạn 1 loạt giáo trình khác, thiết kế mô hình bìa 

của tài liệu Word trong xây dựng đăng lên Facebook và được anh/em xây dựng thiện 

hành like, cổ vũ, đăng ký và tỏ ra rất quan tâm – tạo sự hứng khởi.  

- Tối ngày 07/11/2019 bổ sung thêm các bài tập thực hành vào giáo trình, thêm 

phần mở đầu, phân tách ra các chương, phần.  

- Ngày 10/11/2019 nhân lúc đang biên soạn các giáo trình bằng Word, khi làm 

thực tế mới nhớ ra các vấn đề nên soạn ra 1 loạt bài tập hữu ích.  

- Ngày 11/11/2019 nhân lúc hứng khởi viết thêm được rất nhiều nội dung, chụp 

nhiều ảnh minh họa.  

- Tối 14/11/2019 sau khi xem xong trận Việt Nam thắng UAE 1-0 ở giải vòng loại 

World Cup lại viết tiếp thêm các nội dung về đồ họa.  

- Tối 27/11/2019 sau khi đi dạy lớp Kỹ sư QS khóa 12 về, tắm rửa ăn tối xong vẫn 

ngồi vào bàn viết thêm nhiều nội dung, chụp ảnh minh họa giáo trình.  

- Sáng sớm 28/11/2019 chợt nhớ lại trao đổi với 1 bạn Diệu Phong học viên lớp 

Kỹ sư QS tối qua, liền nảy ra ý tưởng đưa 1 vài đoạn từ cuốn Cha giàu Cha nghèo và 

Bí mật tư duy triệu phú vào làm ví dụ trình bày văn bản, một công đôi việc giới thiệu 

bạn đọc tài liệu Word này những đoạn hay của mấy cuốn kia.  

- Từ 29/11/2019 – 02/12/2019 liên tục viết thêm rất nhiều nội dung, design thêm 

bìa tài liệu.  

- Ngày 04/12/2019 tiếp tục viết thêm và hoàn chỉnh tài liệu.  

- Tháng 02-03/2020 ấp ủ ý tưởng đào tạo chương trình tin học văn phòng xây 

dựng, tuy nhiên tìm file Word gốc bản thảo giáo trình không thấy đâu, lại phải khôi 

phục từ bản pdf và trình bày lại. Khi đó nảy ý tưởng là sẽ trình bày lại theo lượng kiến 

thức của từng buổi học. 

- Ngày 30/07/2021 cập nhập link bài tập để training nhóm tình nguyện làm tài liệu 

về đầu tư, đang trong đợt giãn cách thực hiện chỉ thị 16 phòng chống dịch bênh Covid. 

- Lộ trình (RoadMap): Tác giả sẽ xuất bản version 1.0, sau đó sẽ tiếp thu các phản 

hồi góp ý của bạn đọc hoặc tự đọc lại, nghiên cứu để nâng cấp nội dung tốt hơn ở các 

version sau. 

  


